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Preface

How to use this guide

Purpose of This guide describes the procedures for installing the GeneMapper®
this guide ID-X Software Version 1.2.

Chapter 1, Getting Started — Provides a roadmap to help you
determine the best approach for installing the GeneMapper /D-
X v1.2 software on the target computer.

Chapter 2, Installation Requirements — Contains the
specifications for the computers that are targeted for a new
GeneMapper ID-X v1.2 software installation.

Chapter 3, Performing GeneMapper® ID-X v1.2
Pre-Installation Procedures — Provides procedures on backing
up and exporting application data and objects, and on
uninstalling GeneMapper® ID Software Version 3.x.

Chapter 4, Performing a New Software Installation —
Provides procedures for installing a new version of the full or
client software (replacing GeneMapper ID v3.x or as a new
installation) on a Data Collection or non-Data Collection
computer.

Chapter 5, Performing an Upgrade — Provides procedures for
installing the full or client software on a Data Collection or non-
Data Collection computer currently running GeneMapper /D-X
v1.0/1.0.1/1.1/1.1.1.

Chapter 6, Performing Post-Installation Procedures —
Describes the basic functions of registering the software,
logging into and out of the computer, and general information
following an installation.

Chapter 7, Setting Up Autoanalysis — Describes how to set up
your system to perform automatic local analysis of .fsa or .hid
sample files generated on the Data Collection computer.

GeneMapper® ID-X Software v1.2 Installation Guide vii



Preface
How to use this guide

Audience

Assumptions

Text conventions

viii

* Appendix A, Installing the Generic Updater Software —
Provides the procedure for installing the Generic Updater
Software.

* Appendix B, Troubleshooting the Installation — Provides
possible avenues for troubleshooting and resolving software
installation problems.

* Appendix C, Glossary of Terms — Defines the terms
commonly used throughout the installation guide.

Note: For instructions on configuring the administrative features of
the software, see the GeneMapper® ID-X Sofiware v1.0
Administrator’s Guide. For instructions on configuring the software
to prepare for analysis, see the GeneMapper® ID-X Sofiware v1.0
Getting Started Guide and the GeneMapper® ID-X Sofiware Online
Help.

This guide is written for laboratory personnel responsible for installing
the GeneMapper /D-X Software v1.2.

This guide assumes that you have a working knowledge of the
Microsoft® Windows® operating system.

This guide uses the following conventions:
* Bold indicates user action. For example:
Enter 0, then press Enter for each of the remaining fields.

 [talic text indicates new or important words and is also used for
emphasis. For example:

Before analyzing, always prepare fresh matrix.

* A right arrow bracket ( » ) separates successive commands you
select from a drop-down or shortcut menu. For example:

Select File » Open » Spot Set.

Right-click the sample row, then select View Filter »
View All Runs.

GeneMapper® ID-X Software v1.2 Installation Guide



Preface
How to use this guide

User attention  Two user attention words appear in Applied Biosystems user
words documentation. Each word implies a particular level of observation
or action as described below.

Note: Provides information that may be of interest or help but is not
critical to the use of the product.

IMPORTANT! Provides information that is necessary for proper
instrument operation, accurate chemistry kit use, or safe use of a
chemical.

Examples of the user attention words appear below:

Note: The size of the column affects the run time.

Note: The Calibrate function is also available in the Control
Console.

IMPORTANT! Make certain that you uninstall the GeneMapper® ID
v3.2 software before you install the GeneMapper /D-X v1.2 software
on the target computer.

IMPORTANT! You must create a separate Sample Entry Spreadsheet
for each 96-well plate.

GeneMapper® ID-X Software v1.2 Installation Guide ix



Preface
How to obtain support

How to obtain support

For HID support send an e-mail to:
HIDTechSupport@appliedbiosystems.com, or call (from within
North America only) 888.821.4443 and select option 1. For support
outside North America and internationally, please contact your
local support office or visit the Applied Biosystems support page to
obtain contact information.

For the latest services and support information for all locations, go to
http://www.appliedbiosystems.com, then click Support. At the
Support page, you can:

* Access worldwide telephone and fax numbers to contact
Applied Biosystems Technical Support and Sales facilities.

» Search through frequently asked questions (FAQs).
* Submit a question directly to Technical Support.

* Order Applied Biosystems user documents, MSDSs,
certificates of analysis, and other related documents.

* Download PDF documents.
* Obtain information about customer training.

* Download software updates and patches.

X GeneMapper® ID-X Software v1.2 Installation Guide
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n Chapter 1 Getting Started

Start here: Getting the most out of this guide

Start here: Getting the most out of this guide

Installation guide  This chapter presents an overview of the installation options
overview available for GeneMapper® ID-X software Version 1.2. To benefit
from this guide, you need to be familiar with your current computer
and GeneMapper® ID Software v.3.1 or v3.2 setup (if applicable).

To get started:

1. Read through Chapter 1 to become familiar with your
installation options.

See Chapter 2 for general installation requirements.
See Chapter 3 for pre-installation instructions.

See Chapter 4 for full installation instructions.

See Chapter 5 for client installation instructions.
See Chapter 6 for post-installation instructions.

See Chapter 7 for autoanalysis setup instructions.

© N 2 o &~ 0D

See Appendix A, Installing the Generic Updater Software for
generic updater installation instructions.

9. See Appendix B, Troubleshooting the Installation for
troubleshooting instructions.

10. See Appendix C, Glossary of Terms, for a definition of terms
used frequently in this manual.

After you have read the applicable chapters in this guide and are
installing your software, refer to the GeneMapper® ID-X software
Administrator s Guide for information on configuring the
GeneMapper® ID-X software administrative features and electronic
data chain of custody systems.

2 GeneMapper® ID-X Software v1.2 Installation Guide



Chapter 1 Getting Started n

Installation options

Installation options

Installation options for the GeneMapper® ID-X software are based on
the type of computer you use, the GeneMapper® ID or GeneMapper®
ID-X software currently installed, and your database-sharing
requirements.

If your computer has GeneMapper /D-X v1.0/1.0.1/1.1/1.1.1
installed, you can upgrade to GeneMapper /D-X v1.2. Refer to
Chapter 5, “Performing an Upgrade.”

You can either install a full version of the software, which consists of
both the GeneMapper ID-X software and the database, or you can
install a client version of the software, which consists only of the
GeneMapper ID-X software. The full version on a computer can
function as the database host for the client. Multiple clients can
connect to the same database through a network connection for easy
data sharing.

The following table provides information on the different types of
installations and where to locate the corresponding information in
this guide. It also provides the different Data Collection (DC) and
non-Data Collection (non-DC) computer options for autoanalysis

(AA).

Note: If your computer has GeneMapper ID software installed,
make certain that you upgrade all client and full software versions
from GeneMapper ID Software v3.1 to v3.2.x before you perform a
v1.2 installation.

GeneMapper® ID-X Software v1.2 Installation Guide 3
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Table 1 Installation options summary
Install Scenarios Approx
Igstall for DC/Non-DC Install Description Time 31t 3730 310% | 3500*
ype Computers Req’d AA AA AA AA
A computer without any 1 hour Remote | Remote | NA NA
GeneMapper ID or GeneMapper ID-
X installed or Data Collection
Full New Full | Non- Software installed.
install Gene- DC Insert the CD and follow the
(page 40) Mapper®  (stand- instructions to install
ID-Xv1.2  alone) ’
Need registration code provided
with the software before using the
software.
A computer with Data Collection 15 min. Local Local NA Local
Software installed.
gg_ Insert the CD and follow the
. instructions to install.
install

Need registration code provided
with the software.

suoido uonelelsuy
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Install

Type

Install Scenarios
for DC/Non-DC

Computers
InS place
of Gene- = Non-
Mapper® DC
ID v3.2 (stand-
' alone)
DC
Co-
install

Install Description

e A computer with only GeneMapper
ID v3.2 installed.

¢ Insert the GeneMapper ID-X v1.2
Full Install CD

¢ |[nstallation stops when installer
detects GeneMapper ID v3.2.

e Manually export GeneMapper ID
v3.2 data using the Export Utility on
the GeneMapper ID-X v1.2 Full
Install CD (Disk 1)

e Manually uninstall GeneMapper ID
v3.2.

e |Install the full GeneMapper ID-X v1.2
and follow the instructions.

¢ Need registration code provided
with the software.

Launch Data Collection Software, then
perform the same procedure as the
standalone installation.

Approx
Time
Req’d

1 hour

15 min.

31xx¥
AA

3730%
AA

Remote | Remote

Local

Local

310%

NA

NA

3500%

NA

Local

suopdo uoe)esul
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Install
Type

Client*
install
(page 49)

Install Scenarios Approx t + + +
for DC/Non-DC Install Description Time 32\)2( 3;20 3,;A0 32A90
Computers Req’d
A computer without any 15 min. Remote = Remote | NA NA
GeneMapper ID or GeneMapper ID-
X installed or Data Collection
Non- Software installed.
(Zfand- Insert the CD and follow the
N alone) instructions to install.
Cﬁgﬂ Need registration code provided
Gene- with the software before using the
Mapp or® software.
ID-Xv1.2 A computer with Data Collection 15 min. Local Local NA Local
Software installed.
gg_ Insert the CD and follow the
install instructions to install.
Need registration code provided
with the software.
A computer with GeneMapper ID 15 min. Remote = Remote | NA NA
v3.2 installed.
Insert a GeneMapper ID-X v1.2 client
version installation CD
Installation stops when installer
detects GeneMapper ID v3.2.
In place’ | Manuall t GeneMapper ID
of Gene- on- anually export GeneMapper |
Mapper® DC v3.2 data using the Export Utility on
ID "7; > (stand- the GeneMapper ID-X v1.2 Full
: alone) Install CD (Disk 1)

Manually uninstall GeneMapper ID
v3.2.

Install the GeneMapper ID-X v1.2
Client version.

Need registration code provided
with the software.

suoido uonelelsuy
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Install Scenarios

Install for DC/Non-DC
yp Computers
— In place$
|fl:£tz rlllt of Gene- | DC
(cont’d) Mapper® | Co-
(page 49) ID v3.2 install

Install Description

A computer with GeneMapper ID
v3.2 and Data Collection Software
installed.

Insert a GeneMapper ID-X v1.2 client
install CD

Installation stops when installer
detects GeneMapper ID v3.2.

Manually export GeneMapper ID
v3.2 data using the Export Utility on
the GeneMapper ID-X v1.2 Full
Install CD (Disk 1)

Manually uninstall GeneMapper ID
v3.2.

Install the GeneMapper ID-X client
version 1.2.

Need registration code provided
with the software.

Approx
Time
Req’d

15 min.

31xx¥
AA

Local

3730%
AA

Local

310 | 3500*
AA AA
NA Local

suopdo uoe)esul
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Install
Type

Upgrade
to Full
Gene-
Mapper®
ID-X v1.2
(page 62)

Install Scenarios

Approx

¥ + + ¥
for DC/Non-DC Install Description Time 32\)2( 3;20 3,;A0 32A90
Computers Req’d
A computer with the full 1 hour Remote = Remote | NA NA
GeneMapper ID-X v1.0, v1.0.1, vi1.1,
or vi.1.1 installed.
Insert Full GMID-X v1.2 Upgrade
Non- CD, manually export data objects
DC (projects, analysis methods, etc.)
In place (stand- Uninstall the old GeneMapper ID-X
of Full alone) version.
Gene- Install the GeneMapper ID-X v1.2.
Mapper® ; :
Use the registration code from
ID-X previous version to launch the
‘1’16(1)’ 14 software.
1.1.1 Computer with full GeneMapper ID- | 15 min. | Local Local NA Local
Xv1.0,v1.0.1,v1.1,0rv1.1.1
DC installed.
Co- Insert the Full GMID-X v1.2 Upgrade
install CD.

Software detects the previous
version and automatically upgrades.

suoido uonelelsuy
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Install Scenarios

Approx

¥ + + ¥
I?“Z" for DC/Non-DC Install Description Time 32\)2( 3;20 3,;A0 32A90
yp Computers Req’d
A computer with GeneMapper ID-X 1 hour Remote @ Remote | NA NA
v1.0, v1.0.1, v1.1, or v1.1.1 Client
installed.
Non- Insert the Client GMID-X v1.2
DC Upgrade CD.
(stand- Software detects the previous
Upgrade*  In place alone) version and automatically upgrades.
to Client | of Client Use the registration code from
Gene- ene- previous version to launch the
Mapper® = Mapper software.
ID-Xvi.2 | ID-X . :
(page 63) v1.0, A computer with GeneMapper ID-X 15 min. Local Local NA Local
1.01, 1.1, v1.0, v1.0.1, v1.1, or v1.1.1 Client
1.1.1 and Data Collection Software
DC installed.
Co- Insert the Client GMID-X v1.2
install

Upgrade CD.
Software detects the previous

version and automatically upgrades.

¥ Remote autoanalysis (AA) is only available if you are using 31xx and 3730 Data Collection (DC) computers. Local autoanalysis is
only available if you are using 31xx, 3730 and 3500 computers (remote AA is not available for 3500 DC computers). Remote
autoanalysis and local autoanalysis are not available for 310 computers.

§ If GeneMapper ID v3.1 is installed, you must upgrade to GeneMapper ID v3.2 before installing GeneMapper ID-X v1.2.
# To use a client version of the software, a full GeneMapper ID-X program must be installed on another computer.

suopdo uoe)esul

“ pepels bumen | Jeideyd



Chapter 1 Getting Started

Installation options

See Figure 1 to determine the steps to take based on the desired
installation configuration from GeneMapper® ID v3.2.x.

GeneMapper® ID Software v3.2.x options

Is the -
GeneMapper® ID NO R ? ”0”" "I% ”etW
Software v3.2.x installed »| fulorclien
on the computer? installation
YES

Export Manually uninstall the Perform a

» GMID v3.2.x »  GeneMapper® ID » full or client

data# Software v3.2.x installation

F GeneMapper ID Software

Figure 1 Possible GeneMapper® ID-X software v1.2 installation

configurations from GeneMapper® ID v3.2.x.

10
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Chapter 1 Getting Started
Installation options

See Figure 2 to determine the steps to take based on the desired
installation configuration from GeneMapper® ID-X.

GeneMapper® ID-X Software v1.0/1.0.1/1.1/1.1.1 options

Is the o
GeneMapper® ID-X NO R ‘f3 ”orm ? netW
Software v1.0/1.0.1/1.1/1.1.1 g Y torllctl'en
installed on the computer? Instaliation
YES
i Perform a
What type of 310 DC Export . Uninstall the R r
< computer is it? >————> GMID-X > GeneMapper® ID-X —>| full or client
data Software installation
31xx or 3730 DC
Full co-installation on 31xx and 3730 DC or client
What type of installation on 31xx and 3730 DC/non-DC R Perform a full
< upgrade do you »> or client
want to perform? installation
Full non-DC
installation Export Manually uninstall the Perform a
»  GMID-X > GeneMapper® ID-X > full
data¥t Software installation

Figure 2 Possible GeneMapper® ID-X software v1.2 installation
configurations from GeneMapper® ID-X software
v1.0/1.0.1/1.1/1.1.1.

GeneMapper® ID-X Software v1.2 Installation Guide 11
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Chapter 2

Installation Requirements

This chapter covers:

Getting Started

B Installation CDs. . ....... ... . i 14
i B Full installation computer requirements . ................ 16
Chapter 2 B Client installation computer requirements ............... 18
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m Chapter 2 Installation Requirements
Installation CDs

Installation CDs

Four different installation CDs are available:

* New full installation (with registration code) — The two
GeneMapper® ID-X Software Version 1.2 Full Install CDs
(Disks 1 and 2) install the full version (GeneMapper /D-X
Software and multi-user database) on the target computer. The
full version CDs also include extra Generic Updater Software
and an installation Export Utility. If your computer has
GeneMapper ID v3.x installed, you will need to uninstall the
GeneMapper ID v3.x software before installing GeneMapper
ID-X v1.2. You can install the software on any compatible
computer, but Applied Biosystems does not recommend using a
computer that has the GeneMapper /D-X Full version co-
installed with a data collection software as the host computer
that connects to multiple GeneMapper /D-X Client computers.

* Client installation (with registration code) — The
GeneMapper® ID-X Software Version 1.2 Client Install CD
installs the client GeneMapper /D-X Software on the target
computer. You can install the client on any compatible computer
(including one running Data Collection Software) and connect
to any multi-user database on the same local area network.

+ Full upgrade (existing registration code) — The GeneMapper®
ID-X Software Version 1.2 Full Upgrade Install CD
automatically installs the full GeneMapper /D-X Software v1.2
on a Data Collection computer that has v1.0/1.0.1/1.1/1.1.1
installed. For a non-Data Collection computer and a client-to-
full installation, you must uninstall v1.0/1.0.1/1.1/ 1.1.1
software prior to the installation. You can install the software on
any target computer already running GeneMapper ID-X
Software by following these guidelines. Use the registration
information from the GeneMapper /D-X v1.0/1.0.1/1.1/1.1.1 to
launch the GeneMapper ID-X v1.2 software.

14 GeneMapper® ID-X Software v1.2 Installation Guide



Chapter 2 Installation Requirements n

Installation CDs

* Client upgrade (existing registration code) — The
GeneMapper® ID-X Software Version 1.2 Client Upgrade
Install CD installs the client GeneMapper /D-X Software v1.2
on the target computer. To perform a full-to-client installation,
you must first uninstall the full installation. You can install the
software on any target computer already running GeneMapper
ID-X Software v1.0/1.0.1/1.1/1.1.1.

Note: If you upgrade on a client computer, you must also
upgrade the computer that hosts the full multi-user database on
the same local area network.

An additional GeneMapper® ID-X Software Documentation CD
comes with the software. This CD includes all installation and
associated GeneMapper /D-X documentation.

Note: The GeneMapper® ID-X Software Version 1.2 Installation
Guide and supporting documentation are provided on a separate CD.
To open the user documentation on the CD, you need Adobe®
Acrobat® Reader® software. Download from www.adobe.com or
www.appliedbiosystems.com/support/software.

GeneMapper® ID-X Software v1.2 Installation Guide 15
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m Chapter 2 Installation Requirements
Full installation computer requirements

Full installation computer requirements

Minimum  Table 2 shows the recommended and minimum computer
configurations  configurations for a new full installation (the GeneMapper® ID-X
Software v1.2 and database).

Note: To install the GeneMapper /D-X software, you need a local
user account with administrative privileges. You can run the
computer on regional settings but you need an English Operating
System.

Table 2 Computer requirements for a new full installation

Component Recommended Configuration Minimum Configuration*

IMPORTANT! The GeneMapper® ID-X Software will not function properly on computers with
multiple physical processors. The GeneMapper® ID-X Software requires a single-processor or dual-
core processor compuiter. It is not advised to install the software on a computer with other Oracle® or
SQLPIlus applications and clients, other than the database that is installed with the Data Collection
Software. If you must run other applications, install GeneMapper ID-X first.

Computer e Intel Pentium® IV processor, >2.8 GHz ¢ Intel Pentium® processor, 733 MHz
e 1GB of RAM e 1GB of RAM
e Two 120-GB hard drives$ ¢ Free disk space:
¢ Free disk space: — 200 MB on the boot drive (drive
~ 200 MB on the boot drive (drive on on which the operating system is
which the operating system is installed)
installed) — 10 GB on the drive on which the
— 10 GB on the drive on which the GeneMapper ID-X Software
GeneMapper ID-X Software resides resides
* 20/48X IDE CD-ROM * 20/48X IDE CD-ROM
e 10/100 NIC with RWU (internal) e 10/100 NIC with RWU (internal)
Monitor e 1024 x 768 pixel resolution e 1024 x 768 pixel resolution
® 19-inch color monitor e 17-inch color monitor
Operating Windows Vista® Business (SP1), Windows XP Professional (SP2 & SP3), Windows
System 2000 Professional (SP4)
Ethernet ¢ Network card for database installation
Capability ¢ TCP/IP must be installed before database installation

F¥ The minimum configuration may not provide optimal performance.
§ Required if the Data Collection and GeneMapper® ID-X Software are installed on the same computer.
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Full installation computer requirements

Note: GeneMapper® ID-X software is validated to run on Intel®
Core™ 2 Duo processor computers.

Required time for  The amount of time required to perform a full installation is:

full installation * Approximately 1 hour on a non-Data Collection computer,
depending on the speed of the computer.

* Approximately 15 minutes on a Data Collection computer
(340 SCSI).

* Approximately 1 hour and 15 minutes on other Data Collection
computers.
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Client installation computer requirements

Minimum  Table 3 shows the minimum computer configurations for a client
configurations installation (GeneMapper® ID-X Software v1.2 only).

Note: To log in to the GeneMapper /D-X software, you need a local
user account with administrative privileges. For sites outside the
U.S., you may need to change regional settings to U.S. settings
following software installation.

Table 3 Computer requirements for client installation

Component Minimum Configuration
Client ¢ Intel Pentium® processor, 733 MHz
Computer e 512 RAM for Microsoft® Windows XP or 2000; 1 GB

for Microsoft® Windows Vista® *
e 20/48X IDE CD-ROM drive
e 10/100 NIC with RWU (internal)
e 250 MB of free disk space

e 200 MB on the boot drive (drive on which the
operating system is installed)

Monitor e 1024 x 768 pixel resolution

e 17-inch color monitor (smaller monitor lessens ability
to view a full screen of data)

Operating Windows Vista® Business (SP1), Windows XP
System Professional (SP2 & SP3), Windows 2000 Professional
(SP4)

F Although you can install the GeneMapper ID-X Software on a computer
with 512 MB of RAM, Applied Biosystems recommends using 1 GB or
more of RAM for better performance.

Required time for  The amount of time required to perform a client installation is
client Installation approximately 15 minutes.

Optimizing For recommendations on the number of client connections to use per

computer host to optimize computer performance, contact Applied
performance Biosystems.
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Verifying your computer setup

1. On the desktop, right-click -_g{j My Computer, then select
Properties.

2. Click the General tab of the System Properties dialog box to
verify that your computer meets the minimum requirements for

installation.
System Restore I Automatic Updates I Femote I
General | Computer Mame I Hardware I Advanced
. Operating
Microsoft Windows xP Q SyStem (OS)
Profeszional .
. 'U Version 2002 OS version
u[ 1 Service Pack 2
/
= Reistered to: Latest Service

GeneMagper [D-X Pack installed

Computer:

IntellF) 1 Microprocessor

Pentiurn(R] 4 CPU 2.40GHz g
28 GHz 1.00GE of RaM type and Speed

1 Installed memory

QK I Cancel Apply
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Analyzers and compatible software

Instrumentation Table 4 lists Applied Biosystems Genetic Analyzer instruments and
the corresponding Data Collection and operating system software
that are supported by the GeneMapper® ID-X Software

Table 4 Genetic analyzers and compatible software

Genetic Analysis Instrument

Data Collection Software and

Operating System

4

Applied Biosystems

g;&j 3500 Series Genetic

Analyzer

ABI PRisM® 310
E Genetic Analyzer

3500 Data Collection v1.0
Windows Vista SP 1

310 Data Collection v3.0 or
v3.1

Windows XP SP 2 or later

h Applied Biosystems
LJ==r | 313031300
Genetic Analyzer

ABI PrisM® 3100/3100-
ET‘_J Avant™ Genetic
Analyzer

3130 Data Collection v3.0/
3130x/ Data Collection v3.0

Windows XP SP 2 or later

3100 Data Collection v2.0/
3100-Avant™ Data
Collection v2.0

Windows 2000 SP 4 or later
and

Windows XP SP 2 or later

)
i | Applied Biosystems
; 3730 Genetic Analyzer¥

3730 Data Collection v3.0
Windows XP SP 2 or later

T The 3730 Genetic Analyzer does not include the 3730x/ 96-capillary
configuration. The 48-capillary configuration is validated for analysis of
data generated from ldentifiler® kits using single-source samples only.
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Overview
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Reminders

This chapter provides procedures that you must perform to install
GeneMapper® ID-X Software v1.2 on computers that have
GeneMapper® ID Software v3.x or GeneMapper® ID-X Software
v1.0/1.0.1/1.1/1.1.1 currently installed.

IMPORTANT! If you are installing GeneMapper /D-X v1.2 software
on a computer without GeneMapper ID v3.x or GeneMapper ID
v1.0/1.01./1.1/1.1.1, proceed to Chapter 4 for full or client
installation instructions.

IMPORTANT! If you are upgrading to GeneMapper /D-X v.1.2 from
GeneMapper ID v3.x or GeneMapper /D-X v1.0/1.0.1/1.1/1.1.1, go
to Chapter 5.

Before installing GeneMapper /D-X software on computers that have
GeneMapper ID v3.x software installed, you must export the data
objects (projects, analysis methods, etc.) as a means of backing up
the data, then uninstall the existing software. Because data objects
are deleted when GeneMapper ID 3.x is uninstalled, if they are not
exported and saved to a different location, they cannot be restored.

The GeneMapper® ID-X Software Version 1.2 Full Install CD
contains a GeneMapper ID v3.2.x Software Export Utility, which
automatically exports all data objects stored within your
GeneMapper ID v3.2.x database and stores the files in a user-defined
location. This utility is only designed to work in conjunction with
GeneMapper ID v3.2 and above. Therefore, if you are still running
GeneMapper ID v3.1 software, upgrade to GeneMapper ID v3.2 to
take advantage of this export utility (see “Requirements for
upgrading GeneMapper® ID v3.1 to GeneMapper® ID v3.2” on
page 24).
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Upgrade to GeneMapper ID v3.2 if you also wish to import the
exported files into GeneMapper ID-X v1.2 once the software is
installed, and if you plan to install the full version of GeneMapper
ID-Xv1.2 on a 3500 Data Collection computer.

Note: GeneMapper ID v3.2.x data objects may be imported and
viewed in GeneMapper /D-X v1.2; however, their use is limited. (See
“Optimizing data sharing” on page 103).
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Requirements for upgrading GeneMapper® ID v3.1
to GeneMapper® ID v3.2

To upgrade from GeneMapper ID v3.1 to GeneMapper ID v3.2, you
must have a GeneMapper® ID Software v3.2 Installation CD and a
valid GeneMapper ID v3.1 registration code. If you do not have one
or both of these items, please contact your local technical support
organization.

Exporting GeneMapper® ID v3.2.x data

24

To export data, you can use the Export Utility to automatically export
all data objects from the GeneMapper Manager and Panel Manager
within the GeneMapper® ID Software v3.2.x application.
Alternatively, you can export each data object manually.

Applied Biosystems recommends that you use the Export Utility to
more efficiently export data. Once the data is exported and saved to a
new location, archive these objects using your lab's standard
procedure.

IMPORTANT! You can only export data using the Export Utility
when upgrading from GeneMapper ID v3.2.x. When upgrading from
GeneMapper /D-X v1.0/1.0.1/1.1/1.1.1 to v1.2, you must export
GeneMapper /D-X data manually. See “Manually exporting
GeneMapper ID v3.2 or GeneMapper ID-X v1.0/1.0.1/1.1/1.1.1 data
objects” on page 26.
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Using the export utility (GeneMapper® ID v3.2.x software
only)

Exporting 1. Insert the GeneMapper® ID-X Software Version 1.2 Full Install
GeneMapper ID CD into the CD drive.

v3.2.x data with _
utility tool 2. On the splash screen, click Export Data from GeneMapper

ID v3.2 or 3.2.1.

Note: If there is no GeneMapper ID v3.2 on the target system,
the export button is disabled.

& GeneMapper® ID-X v1.2

"www.agp'Iieggiosys'tems.com [ [ L it A A‘%mﬁ;%m

MM—M B B s GeneMapper®

ID-X
ftwa jersion 1.2
Main Menu

About GeneMapper® D+
a2

| $ — il Export Data from Genebapper ID v3.2 or
Install GeneM apper® |0 - Application
Software Extras

©1908-2008 Applied Biosystams. All rights reservad.
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3. When the Export tool window is displayed, click Browse to
specify the location to save all exported files, or enter a
destination folder in the field provided:

& GeneMapper ID 3.2x Export Tool

Genetapper ID 3.2x Export Tool will export your existing data into the destination folder specified below .

Flease enter your destination folder

C:1abapps\gmid)&AppliedBiosystemd | ’ Browse ]

IMPORTANT! Choose an export location outside the
Applied Biosystems » GeneMapper application folder. The
GeneMapper folder is deleted when GeneMapper ID v3.x is
uninstalled.

4. Click Export.
 If the utility detects a conflict with the location specified,
an error message is displayed. Follow the instructions
given in the error messages before proceeding. These error
messages include:
—No destination is specified for export files. Please select
a destination.
—Specified location does not exist. Please select a new
location.
—Access to specified location denied. Please check folder
permissions or select a new location.
—You have chosen to export data to the
Applied Biosystems » GeneMapper application
folder. This folder is deleted when GeneMapper ID 3.2
is uninstalled. Select a location outside of the
Applied Biosystems » GeneMapper application
folder.
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 If the export is successful the following message is
displayed:

Export Complete

\i) All GMID 3.2 projects and analysis files were successfully exported to <C:\Documents and Settingsisimn1{Desktop>

If you wish to install GMID-X to this computer, you must first manually uninstall GMID 3.2 software.
Uninstallation of GMID 3.2 software must be performed through Add/Remove Program found in the Control Panel,
Please perform GMID-X new installation after this step.

» If the export is only partially successful, the following
message is displayed:

Export Errors

@ One or more data objects failed to export to <ClabappsomidaApplisdBinsystems=. Would you like to view the log file for details?

Proceed to the log file and manually export all data objects
that failed to export.

5. After you have exported all your files, proceed to “Uninstalling
the GeneMapper ID v3.2 and GeneMapper ID-X
v1.0/1.0.1/1.1/1.1.1 software” on page 28.
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Uninstalling the GeneMapper ID v3.2 and
GeneMapper ID-X v1.0/1.0.1/1.1/1.1.1 software

IMPORTANT! You must restart your computer before uninstalling. If
you forget to do so, upon running the uninstall, the computer
prompts you to restart your computer (click Cancel to exit the
uninstall). If you have already restarted your computer, click OK to
continue the uninstall.

IMPORTANT! If you intend to install the full or client GeneMapper
ID-X v1.2 software on a computer running GeneMapper ID v3.2
software or GeneMapper /D-X V1.0/1.0.1/1.1/1.1.1 software, you
must uninstall your existing software, then install GeneMapper /D-X
v1.2.

If you intend to upgrade to the full GeneMapper ID-X v1.2 software
on a computer running a previous version of the full GeneMapper
ID-X software (stand alone), you must uninstall your existing
software, then install GeneMapper /D-X v1.2. If you are upgrading a
previous version of the client GeneMapper ID-X software on a client
computer, or upgrading a GeneMapper ID-X full version that is co-
installed with Data Collection Software, there is no need to uninstall
the software; the software will automatically upgrade to v1.2.

Follow the steps below to uninstall GeneMapper® ID Software v3.2
and GeneMapper® ID-X Software v1.0/1.0.1/1.1/1.1.1:

1. Log in to the computer using a user account with administrative
privileges.
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2. Close the GeneMapper® ID Software v3.2 or GeneMapper® ID-
X Software v1.0/1.0.1/1.1/1.1.1 and all other applications, then
restart your computer before proceeding with the uninstall.

IMPORTANT! If you do not restart your computer before
proceeding with the uninstall and/or if the uninstall does not
complete successfully the first time, perform this procedure a
second time. If the uninstall still does not work, have a
knowledgeable technician review and proceed with “Running
the clean-up utility” on page 128 or contact Applied Biosystems
Technical Support to proceed.

3. Select Start » Control Panel.

4. Double-click Add or Remove Programs.

Note: If a message indicates that you need administrator rights
or privileges, log off the computer, then log on again as a user
with administrator privileges.

5. Select GeneMapper® ID Software or GeneMapper® ID-X
Software.
6. Click Change/Remove. The InstallShield Wizard opens.

7. In the Welcome page, select Remove, then click Next.

8. At the prompt, click OK to verify the uninstall.
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9. When the Maintenance Complete window opens, select Yes, T
want to restart my computer now.

IMPORTANT! For the uninstallation to complete, you must
restart the computer. Do not install GeneMapper ID-X v1.2
software without first restarting your computer.

IMPORTANT! After you restart your computer, a command
prompt window may be displayed. This window can take up to
40 seconds to close. Do not close this window. Wait for the
process to complete on its own. If you close the window, the
GeneMapper /D-X software may not install correctly.
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Enabling autoanalysis

Use autoanalysis if you want to communicate with the Data
Collection Software for the collection and processing of .fsa and .hid
sample files, and for data analysis.

For installations in which you want autoanalysis enabled, follow the
procedures below:

 Start the Data Collection Software to enable autoanalysis during
the full and client installation procedures (see page 32).

* Retrieve the Data Collection computer name to enable
autoanalysis during the full and client installation procedure
(see page 35).

* Retrieve the Host Computer name to enable client access to the
host computer during the client installation procedure (see
page 37).

IMPORTANT! The Data Collection Software must be running during
installation if you wish to run autoanalysis.

IMPORTANT! Remote autoanalysis is only accessible from 31xx and
3730 Data Collection (DC) computers, not from 3500 DC
computers. However, if you are using 31xx, 3730 and 3500
computers for co-installed applications, you can perform local
autoanalysis.
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Starting the Data Collection Software on the Data Collection
computer

Starting the Data  Start the Data Collection Software on the 31xx or 3730 Data
Collection Collection computer before installing the full GeneMapper® ID-X
Software to  Software v1.2 on your computer for a remote autoanalysis
enable configuration, or on the 31xx, 3730 or 3500 Data Collection
autoanalysis computer for a co-installation.

Note: For 310 Data Collection computers only: The following Data
Collection Software sections are not applicable. Proceed to
“Performing a full installation” on page 40 or “Performing a client
installation” on page 49.

Starting the Data  Use the following procedure to enable autoanalysis only.

Collection .
Software on 31XX 1. On the 31xx or 3730 Data Collection computer, select
and 3730 Start » All Programs » Applied Biosystems »
computers Data Collection » Run <Data Collection version>, where

<Data Collection version> is:
* 3100/3100-Avant™ Data Collection v2.0,
or
* 3130/3130x/ Data Collection v3.0.

2. After the Service Console opens, wait until all four symbols
change to green squares.
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m Service Console |Z”E‘E|

m Service Console |Z”E‘E|

Messaging Service /\

Data Service O
Instrumert Service O

Messaging Service

Data Service

Instrumert Service

Wiever O Wiever

Note: If the software services do not start automatically, click
Start All.

3. If the Data Collection Software requires a password, a login
dialog box opens. Enter the Login Name and Password, then
click OK.

Note: If you do not know the Data Collection computer Login
Name or Password, contact your Data Collection computer
administrator.

4. Verify that the Data Collection Software started without errors:

a. In the Service Console, right-click the square beside Data
Service, then select Show Console to display the Data
Service output message box.

E] Service Console |Z”E‘E|

Messaging Service

== Right-click here

Data Service

Stop

Instrumert Service

Wiever
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b. Verify that no errors are displayed in the lower pane of the
message box, then close the Data Service output message
box.

[INFO,Defaule] 10:59:33.643 Tound disk space for drive G: = -1
[INFO,Default] getCurrentStatusTypes...

[INFO,Defaule] 10:59:35.718 For testing only: ICFGetManualCont
[INFO,Default] 3130, instrumentTypeNames ga3l00-Avant
[INFO,Default] getCurrentStatusTypes...

[INFO,Default] 10:59:36.562 WARNING: No valid spatial calibrat,,
3 [ >

No errors
displayed

Starting the Data  Use the following procedure to enable autoanalysis only.

34

Collection
Software on the 1. Select Start » Programs » Applied Biosystems »
3500 computer 3500 » Daemon.

Note: It will take approximately 15 seconds for Daemon to populate.

2. TIfthe Server Monitor does not start automatically, select
Start » Programs » Applied Biosystems » 3500 » Server
Monitor.

It will take approximately 2 minutes for the Server Monitor to
set up. During this time, you will see the status icon transition
from a red circle, with an X in the middle (indicating that not all
3500 services are loaded), to the shape of an hour-glass on your
desktop, in the toolbar at the bottom of your desktop.

2445 P

245 Fi

When Server Monitor setup is complete, the icon in the shape of
an hour-glass disappears and a checkmark icon appears,
indicating that the 3500 Server Monitor started and all 3500
services loaded.

g R 247
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3. Launch the application. Select: Start » Programs » Applied
Biosystems » 3500.

The 3500 Series Data Collection Software splash screen
appears, followed by the Dashboard and Log In dialog box.

4. When the Data Collection Software splash screen disappears,
log in from the Dashboard by entering the User Name and
Password, then click OK.

Note: If you do not know the Data Collection computer User
Name or Password, contact your Data Collection computer
administrator.

The 3500 Series Data Collection Software splash screen re-
appears. This screen remains active for a few seconds while the
3500 Series Data Collection Software launches and the
Dashboard appears.

Obtaining the Data Collection computer name

If you are installing the client GeneMapper® ID-X Software v1.2 on
a non-Data Collection computer to enable remote autoanalysis, you
must first obtain the name of the 31xx or 3730 Data Collection
computer:

1. On the 31xx or 3730 Data Collection computer, right-click My
Computer, select Properties, then select the Computer Name
tab to view the full computer name.
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System Properties

System Restore Automatic Updates Femote
General Camputer Hame Hardware Advanced
7;1 Windows uses the following information to identify your computer
on the network.

Computer description:

For example: "Kitchen Computer or "Mary's

Computer. Computer
Full computer name: Genebapper ID-¥ name
workgroup: WORKGROUP

To use the Metwark |dentification Wizard ta join a Metwork |0
domain and create a local uzer account, click Metwork

0.

To rename this computer of join a domain, click Change.

[ Ok H Cancel ]

2. Make a note of the computer name and enter this name when
prompted during installation of the client GeneMapper® ID-X
Software.
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Obtaining the GeneMapper® ID-X Software host
computer name

Before you install the client GeneMapper® ID-X Software, obtain the
name of the multi-user database host computer to enable access to
the host computer from a network:

1. On the multiuser database host computer, right-click My
Computer, select Properties, then select the Computer Name
tab.

System Properties

System Restore Automatic Updates Femote
General Camputer Hame Hardware Advanced
7%] Windows uses the following information to identify your computer
on the network.

Computer description:

For example: "Kitchen Computer or "Mary's

Computer.
Full computer name: GeneMapper ID-X Computer
‘workgroup: WORKGROUP name
To uge the Metwork, [dentification \Wizard to join a
domain and create a local user account, click MNetwaork et

ID.

To rename this computer of join a domain, click Change.

[ Ok H Cancel ]

2. Make a note of the computer name and enter this name when
prompted during installation of the client GeneMapper® ID-X
Software.
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Overview

Overview

This chapter describes how to perform a new full or client
installation of the GeneMapper® ID-X Software Version 1.2 on your
target computer.

Note: If you have GeneMapper® ID Software v3.x or
GeneMapper® ID-X Software v1.0/1.0.1./1.1/1.1.1 on your computer
and haven’t already performed pre-installation tasks, go back to
Chapter 3, “Performing GeneMapper® ID-X v1.2 Pre-Installation
Procedures,” on page 21 for additional instructions. The installation
may fail if these tasks are not performed first.

Performing a full installation

A full GeneMapper® ID-X Software v1.2 installation:
* Installs the GeneMapper /D-X software and database.

* Enables the GeneMapper /D-X v1.2 software to serve as the
host for multiple client computers needing access to the
database.

Note: It is not recommended that the Data Collection computer
function as the host computer due to performance constraints.

User account requirements for full Installations

Log on
requirements

40

To perform a new full installation of GeneMapper /D-X v1.2, you
must:

* Log on to the local computer (not a network domain).
» Use an Administrator account (unrestricted access).

Note: After the software is installed, you can run the GeneMapper
ID-X v1.2 without using an Administrator account.
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Verifying user 1. On the desktop, select Start » Control Panel.

accounts . )
. In the Control Panel window, double-click User Accounts.

3. In the Users tab, verify that the user account belongs to the
Administrators group and the domain name is the same as the
computer name.

User Accounts E' g'

Users | Advanced

Use the list below to grant or deny users access to your
&) computer, and ko change passwords and other settings.

Users For this computer:

User Mame Daornain Group ~
IL % administrator _ Administratars
lgGuest D4EBPIF351 Guests | B Be|ongs to the

Administrators

Domain is the

_ same as the
Add... ] [ Remove ] [ Properties ] CompUter name
Password for Administrator
g Ta change the password For Administrator, click Reset
Password,

Ok H Cancel ]

Full installation requirements

Important Below is a list of items to take into consideration prior to installing
reminders GeneMapper ID-X v1.2.

* DO NOT cancel an installation before the installation process is
finished. If you do so, or if the installation otherwise stalls, you
may need technical support to perform an uninstall. To uninstall
your installation, see “Uninstalling the GeneMapper® ID-X
Software” on page 126. If uninstallation fails, contact your local
Applied Biosystems technical support organization.
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L]

In a co-installation (Data Collection computer with Data
Collection Software), you are limited to one client connection.
To allow more client connections to the database, install the full
version GeneMapper® ID-X Software (software and database)
on a computer other than the Data Collection (DC) computer.

When installing GeneMapper /D-X v1.2 on a 31xx or 3730 DC
Computer that has GeneMapper ID v3.2 software, you do not
need to uninstall the v3.2 software; however, you must recreate
all the files associated with autoanalysis (e.g. Results Groups)
because old files created as part of the GeneMapper ID v3.2
integration cannot be reused. See Chapter 7, “Setting Up
Autoanalysis.”

When you install GeneMapper ID-X v1.2 ona 31xx or 3730 DC
computer as a co-installation, or on a non-DC computer and you
intend to access the DC computer for remote autoanalysis, the
Data Collection Software must be running on the DC Computer.
For more information on starting the Data Collection Software,
see page 32.

Note: If you install the GeneMapper /D-X v1.2 software on the
3500 DC computer (co-installation), you will be able use the
3500 computer to perform local autoanalysis. However, if you
install the GeneMapper /D-X v1.2 software on a non-DC
computer, you will not be able to access the 3500 computer to
perform remote autoanalysis.

To set up remote autoanalysis, obtain the computer name of the
DC Computer: Right-click My Computer on the DC computer,
select Properties, then select the Computer Name tab to view
and record the full computer name. You are required to enter
this during installation (see page 35).

Installing the Full GeneMapper® ID-X Software

(DC and non-DC

42

Full installation

To install the Full GeneMapper® ID-X Software v1.2 onto your

procedure computer:

computers) 1.

Insert the first disk of the GeneMapper® ID-X Software Version
1.2 Full Install CDs into the CD drive (if not inserted during use
of the Export Utility).

GeneMapper® ID-X Software v1.2 Installation Guide



Chapter 4 Performing a New Software Installation
Performing a full installation

2. On the splash screen, double-click Install GeneMapper ID-X
v1.2 Application to start the installer.

Note: If you install on a DC or non-DC computer running
GeneMapper ID v3.2, you will be prompted to insert the full
GeneMapper /D-X v1.2 to export data objects. When you are
done, uninstall the GeneMapper ID v3.2, then continue with the
GeneMapper ID-X v1.2 installation. For additional information
on exporting data objects, see “Exporting GeneMapper 1D
v3.2.x data with utility tool” on page 25.

3. Close all other applications and windows (except the Data
Collection application), then click OK to close the following

message.

GeneMapper® [D-X v1.2

-
1 ) Close all running applications before proceeding with the installation.

4. In the Welcome window, click Next.

5. Review the installation requirements status, then click Next.
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6. Select Remote Autoanalysis or Stand-alone for type of
installation, then click Next:

* Remote Autoanalysis — Select this option to set up remote
autoanalysis. In this configuration, the target computer is
networked to the 31xx or 3730 DC computer. The
autoanalysis manager alerts GeneMapper /D-X when a run
is complete. GeneMapper /D-X then opens, and you can
import the .fsa files into a project and analyze them.

Note: If you install the GeneMapper /D-X v1.2 software
on a non-DC computer, you will not be able to access the
3500 computer to perform remote autoanalysis. Proceed to
step 9.

* Stand-Alone — Select this option if you do not want to set
up remote autoanalysis or if your DC computer is not
networked to the target computer during installation.

IMPORTANT! After the GeneMapper /D-X v1.2 Software
is installed, you cannot switch from stand-alone to remote
autoanalysis. To change the configuration, you must
uninstall, then reinstall the software.

Note: For a co-installation on the 31xx, 3730 and 3500
Data Collection computers, you do not have the option of
selecting stand-alone or remote autoanalysis. You can
optionally set up local autoanalysis later. See “Setting up
autoanalysis on the 31xx or 3730 computer” on page 81 for
instructions.

Note: For the 310 Data Collection computer, autoanalysis
(local or remote) is not available. Proceed to step 9.

Note: If you select Stand-alone, skip step 8 and step 14.
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GeneMapper® ID-X v1.2 le

—
Chooze the setup type that best suits your needs.

_ Remote auto-analysis option will install the: auto-analysis manager utility
to automatically analyze data collected from D ata Collection spstem. IF
you don't have a Data Collection spstem available, you should choose
~ stand-al tict.

[ () Remate Autoanalysis [networked to the instrument computer]

GeneMapper®

[ < Back " Mest » ][ Cancel ]

7. (Remote Autoanalysis only) Select the DC Computer that you
wish to connect to, then click Next.

GeneMapper® ID-X v1.2

 Setup Type
Chooze the setup type that best suits your needs.

_ Select data collection type

GeneMapper® () ABI 3730

[ < Back " Mest » ][ Cancel ]

8. (Remote Autoanalysis only) Enter the full name of the Data
Collection computer that you intend to have support remote
autoanalysis (see page 35), then click Next.
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GeneMapper® ID-X v1.2

Enter Text

Please enter information in the figld below. |

Provide a valid Data Collection spstem name below. If you don't have a Data Collection system
already available, go back to the previous screen and choose a stand-alone installation
instead.

[ < Back " Mest » ][ Cancel

Read the release notes, then click Next.

. Click Next to install the Software to the default location. To

install the GeneMapper® ID-X Software to a drive different
from the default drive, select the destination folder:

a. Verify that the boot drive (drive on which the Windows
operating system is installed) contains at least 200 MB of
available free space.

b. Select a destination folder with at least 10 GB of free
space, then click Next.

IMPORTANT! If you choose an invalid destination such as
A: drive or CD-DVD ROM and click Next, an error
message is displayed saying the drive is invalid. When you
click OK the installation is stopped. To recover, click
Cancel and start the installation over again, using a valid
destination folder.
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GeneMapper® ID-X v1.2

Choose Destination Location

Select folder where setup will install files,

Setup will inztall Genet apper® 10+ +1.2 in the following folder. Tao ingtall it in this folder,
click Mext. Toinstall it in a different folder, click Browse and navigate to the folder in which
you want ta ingtall the Genetapper® |D-x v1.2 software.

Destination Folder

C:\AppliedBiosystemsh

[ <Back || Nest> |[ Cancel ]

11. Select a Setup Type if desired: either Desktop Short Cut and/or
Quick Launcher or deselect both, then click Next.

Setup Type
Choosze the setup type that best suits your needs.

Inztaller will create following shart cuts, if you do not wish to create
them, pleasze uncheck them.

[
/i
/0 Quick Launcher

Desktop Short Cut

< Back " Mest » l[ Cancel
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12.

13.
14.

15.
16.

Read the current settings, then click Next to start the
installation.

IMPORTANT! During installation, a DOS window may open
while DOS commands execute. Do not delete, close, or click the
DOS window. If you accidentally click the DOS window, press
the Esc key to exit the window.

When prompted, insert Disk 2 and follow instructions.

(Remote Autoanalysis only) When GeneMapper® ID-X
Software installation is complete, if you were running the Data
Collection Software, stop the software on the Data Collection
computer by clicking Stop All in the Service Console.

!5=rvir:= Console E]@\EI

Messaging Service

Data Service

Instrumert Service

Wievver

|

Remove the installation CD from the CD drive.

In the InstallShield Wizard Complete page, select Yes, I want to
restart my computer now, then click Finish.

When you finish the installation, proceed to Chapter 6, “Performing
Post-Installation Procedures,” on page 65.

To set up autoanalysis after performing post-installation procedures,
proceed to Chapter 7, “Setting Up Autoanalysis,” on page 73.
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Performing a client installation

A client GeneMapper® ID-X Software v1.2 installation:
» Allows the user access to the GeneMapper ID-X v1.2 software
without a database installed on the same computer.

¢ Connects to one or more database hosts for access to the data
stored in the database and saves data objects back to the
database.

User account requirements for client installations

Log on  To perform a client installation of the GeneMapper® ID-X Software:

requirements * Confirm that the target computer is connected to the database
host computer when you log in. If there is no login window that
connects you to the local area network served by the host, or if
you are not automatically connected, contact your lab’s on-site
technical support department.

* Use an Administrator account (unrestricted access).

Note: After the software is installed, you can run the GeneMapper®
ID-X Software without using an Administrator account.

Verifying user 1. On the desktop, select Start » Control Panel.

accounts . )
2. In the Control Panel window, double-click User Accounts.

3. In the Users tab, verify that the user account belongs to the
Administrators group and the domain name is the same as the
computer name.
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User Accounts E' PZ|
Users | advanced

Use the list below to grant or deny users access to your
computer, and ko change passwords and other settings,

Users For this computer:

User Mame Domain Group L
IL % administrator }
lgGuest D4EBPF351 Guests Be'OngS to the
Administrators
Domain is the
hd same as the
Add... ] [ Remove ] [ Properties ] Cor‘npUter name
Password for Administrator
Ta change the password For Administrator, click Reset
Password,

Ok H Cancel ]

Client installation requirements

Important Below is a list of items to take into consideration before you perform
reminders a client installation:

* DO NOT cancel an installation before the installation process is
finished. If you do so, or if the installation otherwise stalls, you
may need technical support to perform an uninstall. To uninstall
your installation, see “Uninstalling the GeneMapper® ID-X
Software” on page 126. If uninstallation fails, contact your local
Applied Biosystems technical support organization.

e At least one full installation of the same software version must
be performed on another computer for it to act as the database
host for the client.

o Users are required to have a valid user name and password with
an account on the database host computer.
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* You must obtain the name of the database host computer to
enable access to the host computer from a network: Right-click
My Computer on the database host computer, select
Properties, then select the Computer Name tab to view and
record the full computer name. You are required to enter this
name during installation (see page 37).

* When you install GeneMapper ID-X v1.2 on a 31xx, 3730 or
3500 DC Computer as a co-installation, or on a 31xx or 3730
non-DC computer and you intend to access the DC computer for
remote autoanalysis, the Data Collection Software must be
running on the DC computer (see page 32).

Note: If you install the GeneMapper /D-X v1.2 software on the
3500 DC computer (co-installation), you will be able use the
3500 computer to perform local autoanalysis. However, if you
install the GeneMapper /D-X v1.2 software on a non-DC
computer, you will not be able to access the 3500 computer to
perform remote autoanalysis.

» If you choose to set up remote autoanalysis, obtain the
Computer Name of the Data Collection computer: Right-click
My Computer on the Data Collection computer, select
Properties, then select the Computer Name tab to view and
record the full computer name. You are required to enter this
during installation (see page 35).

Installing the Client GeneMapper® ID-X Software

To install the Client GeneMapper® ID-X Software Version 1.2 on
the target computer:

1. Insert the GeneMapper® ID-X Software Version 1.2 Client
Install CD into the CD drive.
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2.

On the splash screen, double-click Install GeneMapper ID-X
v1.2 Client to start the installer.

Note: If you install on a DC or non-DC computer with
GeneMapper ID v3.2, you will be prompted to insert the full
GeneMapper /D-X v1.2 to export data objects. When you are
done, uninstall the GeneMapper ID v3.2, then continue with the
GeneMapper ID-X v1.2 installation. For additional information
on exporting data objects, see “Exporting GeneMapper 1D
v3.2.x data with utility tool” on page 25.

Be sure that the Data Collection Software application is running
but close all other applications and windows, then click OK to
close the following message.

GeneMapper® ID-X v1.2 Client

1 ) Before proceeding with installation, close all running applications and their windows.

N o o »

In the Welcome window, click Next.
Review the installation requirements status, then click Next.
Read the release notes, then click Next.

When prompted, enter the GeneMapper® ID-X Software (GM)
host (server) computer name, then click Next.
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GeneMapper® ID-X v1.2 Client

Enter Text
Fleaze enter information in the field below.

Provide a walid Genetapper® |0+ Databaze Mame below. If pou don't have the
GeneMapper® |D-< Database installed pet, You can stil proceed with the client installation
and ingtall the server later. Genekd apper® |D-x Client requires a valid Genet apper® 1D
[atabase in order to function propely.

[ < Back " Mext > l[ Cancel ]

8. After the installer establishes a connection with the multi-user
database computer, click OK to continue.

GeneMapper® ID-X v1.2 Client rg|

\E) Server connection established.
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9. Select Remote Autoanalysis or Stand-Alone for type of
installation, then click Next.

* Remote Autoanalysis — Select this option to set up remote
autoanalysis. In this configuration, the target computer is
networked to the 31xx or 3730 DC computer. The
autoanalysis manager alerts GeneMapper /D-X when a run
is complete. GeneMapper /D-X then opens, and you can
import the .fsa files into a project and analyze them.

* Stand-Alone — Select this option if you do not want to set
up remote autoanalysis or if your DC computer is not
networked to the target computer during installation.

IMPORTANT! After the GeneMapper /D-Xv1.0 or v1.1
Software is installed, you cannot switch from stand-alone
to remote autoanalysis. To change the configuration, you
must uninstall, then reinstall the software.

Note: For a co-install on the 31xx, 3730, and 3500 Data
Collection computers, you do not have the option of
selecting stand-alone or remote autoanalysis. You can
optionally set up local autoanalysis later. See “Setting up
autoanalysis on the 31xx or 3730 computer” on page 81 for
instructions.

Note: For the 310 Data Collection computer, autoanalysis
(local or remote) is not available. Proceed to step 12.

Note: If you select Stand-alone, skip step 11 and step 14.
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GeneMapper® ID-X v1.2 Client

' Setup Type
Select the setup type that best suits your needs.

' Fiemate auto-analysiz option will install the auto-analysiz manager utility
to automatically analyze data collected from D ata Collection spstem. IF

you don't have a Data Collection spstem available, you should choose
stand-alone option.

GeneMapper®

[ < Back " Mest » ][ Cancel ]

10. (Remote Autoanalysis only) Select the DC Computer that you
wish to connect to, then click Next.

® ID-X v1.2 Client

Setup Type

Select the setup type that best suits your needs.

Select data collection type

GeneMapper® () ABI 3730

[ < Back " Mest » ][ Cancel ]

11. (Remote Autoanalysis only) Enter the full name of the Data
Collection computer that will support the remote autoanalysis
configuration, then click Next.
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GeneMapper® ID-X v1.2 Client

Enter Text
Please enter information in the figld below.

Provide a valid Data Collection spstem name below. If you don't have a Data Collection system
already available, go back to the previous screen and choose a stand-alone installation
instead.

[ < Back " Mest » ][ Cancel ]

12. To install the GeneMapper® ID-X Software to a drive on the

client computer other than the default drive, select the
destination folder and verify that the boot drive (drive on which
the Windows operating system is installed) contains at least
250 MB of available free space.

IMPORTANT! If you choose an invalid destination such as A:
drive or CD-DVD ROM and click Next, an error message is
displayed saying the drive is invalid. When you click OK the
installation is stopped. To recover, click Cancel and start the
installation over again, using a valid destination folder.
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GeneMapper® ID-X v1.2 Client

Choose Destination Location

Select folder where setup will install files. | "h

Setup will install Genetdapper® 10 Client in the following folder.
Ta install it in this folder, click Mest. To install it in a different folder, click Erowse and
navigate to the folder in which you want to install the Genet apper® 10+ Client.

Destination Folder

C:\AppliedBiospstemsh

[ <Back || Mewt> |[ Cancel ]

13. Read the current settings, then click Next to start the
installation.

IMPORTANT! During installation, a DOS window may open
while DOS commands execute. Do not delete, close, or click the
DOS window. If you accidentally click the DOS window, press
the Esc key to exit the window.

14. When installation of the GeneMapper® ID-X Software is
complete, if you were running the Data Collection Software,
stop the software on the Data Collection computer by clicking
Stop All in the Service Console.

15. Remove the installation CD from the CD drive.

16. In the InstallShield Wizard Complete window, select Yes, T
want to restart my computer now, then click Finish.

17. Repeat the procedure for additional client installations.

When you finish all client installations, proceed to Chapter 6,
“Performing Post-Installation Procedures,” on page 65.

To set up autoanalysis after performing post-installation procedures,
proceed to Chapter 7, “Setting Up Autoanalysis,” on page 73.
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Resetting permissions for the installation

58

Resetting
permissions on
folders and files

The client installer specifies folder privileges at the time of the
GeneMapper® ID-X Software installation.

However, the file system permissions set by the system administrator
may not allow the GeneMapper® ID-X Software to access the
GeneMapper folder following installation. Before you run the
software, check the permissions to make sure that the GeneMapper®
ID-X Software can access the GeneMapper folder.

If you do not have the required permissions, you may see a “can't
access file” error message when using the software. To set the
privileges manually, either before running the software or in the
event of an error message:

1. Right-click the AppliedBiosystems folder.
2. Select Properties, then click the Security tab.
3. In the top pane, select Users.

4. In the bottom pane, select Full Control.

AppliedBiosystems Properties rz| E|

General Sharhg| Secuty |Eust0nize

rUp O LEET names:
ﬂ Adminizhators [FOSYEHKATRNDO3 A dministraors]
€7 FAFATOR MwAFR
€7 SvaTEM
ﬂ Uszers [FOSVEMRATRHDO3M se13)

Pernistions for Users Aillow De

3

Full Cartral -~
Modfy ]
Read & Execute

List Folcer Corvents

Rerad

Write
o

Y TR T

“un spevial penissions o T advarces sedings, Adeancec
slics Advanced. = .

ooagocd

v

ok [ camsl [ Ay |
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Upgrade overview

Upgrade overview

This chapter describes how to perform upgrades of the
GeneMapper® ID-X Software Versions 1.0/1.0.1/1.1/1.1.1 on your
target computer.

Note: If you have GeneMapper® ID Software v3.x on your computer
and haven’t already performed pre-installation tasks, go back to
Chapter 3, “Performing GeneMapper® ID-X v1.2 Pre-Installation
Procedures,” on page 21 for additional instructions. The installation
may fail if these tasks are not performed first.

Requirements for upgrading GeneMapper® ID-X
v1.0/1.0.1/1.1/1.1.1 to GeneMapper® ID-X v1.2

60

To upgrade your target computer (client or full) to GeneMapper /D-X
v1.2, make certain that GeneMapper /D-X v1.0/1.0.1/1.1/1.1.1 is
already installed on your system. The upgrade installer works only if
it detects one of these previous versions.

IMPORTANT! When you upgrade on a client computer, you must
also upgrade the computer that hosts the full software version on the
same local area network.

IMPORTANT! You can automatically upgrade client-to-client
versions of the GeneMapper /D-X software on a non-DC computer.
For full installation on a non-DC computer, you must uninstall the
previous version, then install the new full software. If you wish to
upgrade from client-to-full, or from full-to-client versions, you must
also uninstall the previous version, then install the new software.

Note: You can reuse your existing password when upgrading from
GeneMapper /D-X v1.0/1.0.1/1.1/1.1.1 to GeneMapper ID-X v1.2.
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Manually exporting GeneMapper ID v3.2 or
GeneMapper ID-X v1.0/1.0.1/1.1/1.1.1 data
objects

For information on manually exporting files out of GeneMapper ID
v3.x, refer to the section on exporting items from the GeneMapper
Manager in the GeneMapper® ID Software Version 3.1 User's
Guide.

For information on manually exporting files out of GeneMapper /D-
Xv1.0/1.0.1/1.1/1.1.1, refer to the section on exporting items from
the GeneMapper ID-X Manager in the GeneMapper® ID-X Software
Versionl.0 Getting Started Guide.

After you have exported all your files, review the following table to
determine the steps to take next.

Table 1 Installation options following manual export (non-DC or
310 or 31xx DC computer)

Full Installation Client Installation

1. Uninstall GeneMapper ID v3.2. | 1. Uninstall GeneMapper ID v3.2.

See “Uninstalling the See “Uninstalling the
GeneMapper ID v3.2 and GeneMapper ID v3.2 and
GeneMapper ID-X GeneMapper ID-X
v1.0/1.0.1/1.1/1.1.1 software” v1.0/1.0.1/1.1/1.1.1 software”
on page 27. on page 27.

2. Install Full GeneMapper ID-X 2. Install Client GeneMapper ID-X
v1.2. See “Performing a full v1.2. See “Performing a client
installation” on page 40. installation” on page 49.
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Upgrading to the Full GeneMapper® ID-X v1.2
Software

Upgrading to Full
GeneMapper® ID-
X v1.2 onanon-

62

DC computer

To upgrade from the Full GeneMapper® ID-X Software
v1.0/1.0.1/1.1/1.1.1 to the Full GeneMapper® ID-X Software v1.2
on a non-DC computer:

1.

Manually export the data objects (projects, analysis methods,
etc.).

Manually uninstall the old GeneMapper /D-X version using
your computer control panel.

Insert the GeneMapper® ID-X Software Version 1.2 Full
Upgrade Install CD into your CD drive.

In the Welcome Window, click Next.
Read the Release notes, then click Next.

Click Next to install the software to the default location.

or

To install the GeneMapper® ID-X Software to a drive different
from the default drive, select the destination folder.

When the software is installed, remove the installation CD from
the CD drive.

Use the registration code from the previous GeneMapper /D-X
version to launch the software.

The upgrade installation takes approximately 1 hour, depending on
the computer being upgraded.
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To upgrade from the Full GeneMapper® ID-X Software
v1.0/1.0.1/1.1/1.1.1 to the Full GeneMapper® ID-X Software v1.2
on a DC computer (coinstallation):

Note: This is not applicable to the 3500 computer.

. Insert the GeneMapper® ID-X Software Version 1.2 Full

Upgrade Install CD into your CD drive.
In the Welcome Window, click Next.
Read the Release Notes, then click Next.

Click Next to install the Software to the default location.

or

To install the GeneMapper® ID-X Software to a drive different
from the default drive, select the destination folder.

When the software is installed, remove the installation CD from
the CD drive.

The upgrade installation takes approximatelyl5 minutes, depending
on the computer being upgraded.

To upgrade from the Client GeneMapper® ID-X Software
v1.0/1.0.1/1.1/1.1.1 to the Client GeneMapper® ID-X Software
v1.2 on a non-DC computer:

1.

Insert the GeneMapper® ID-X Software Version 1.2 Client
Upgrade Install CD into your CD drive.

In the Welcome Window, click Next.

Read the Release Notes, then click Next.
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4. Click Next to install the Software to the default location.
or
To install the GeneMapper® ID-X Software to a drive different
from the default drive, select the destination folder.

5. When the software is installed, remove the installation CD from
the CD drive.

The upgrade installation takes approximately 15 minutes, depending
on the computer being upgraded.

Upgrading to  To upgrade from the Client GeneMapper® ID-X Software
Client V1.0/1.0.1/1.1/1.1.1 to the Client GeneMapper® ID-X Software
GeneMapper ID-X v1.2 on a DC computer (co-installation):

vi.2onaDC — _
computer Note: This is not applicable to the 3500 computer.

1. Insert the GeneMapper® ID-X Software Version 1.2 Full
Upgrade Install CD into your CD drive.

2. In the Welcome Window, click Next.
3. Read the Release notes, then click Next.

4. Click Next to install the Software to the default location.
or

To install the GeneMapper® ID-X Software to a drive different
from the default drive, select the destination folder.

5. When the software is installed, remove the installation CD from
the CD drive.

The upgrade installation takes approximately 15 minutes, depending
on the computer being upgraded.
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Registering the GeneMapper® ID-X Software

Register the GeneMapper® ID-X Software v1.2 the first time you
start the software on each computer. The registration code is on the
registration card packaged with the software.

Note: If you upgraded from GeneMapper® ID-X Software
v1.0/1.0.1/1.1/1.1.1 to v1.2, use the registration code from the
previous version to launch your software. Your registration code
remains the same.

Enter the same registration code on each computer, based on the
number of users each registration code supports.
1. On the desktop, double-click ..%.... GeneMapper ID-X v1.2 or
select Start » All Programs » Applied Biosystems »
GeneMapper » GeneMapper ID-X v1.2.

2. Complete the Registration dialog box:

o' GeneMapper® ID-X

Product Registration

3. Click OK.
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Logging into GeneMapper® ID-X after installation

1. If the Login dialog box is not displayed in the desktop,

double-click ‘? GeneMapper ID-X v1.2 or

select Start » All Programs » Applied Biosystems »
GeneMapper » GeneMapper ID-X v1.2.

2. In the Login to GeneMapper /D-X dialog box, enter or select
“gmidx” as the administrator account user name and the
temporary password, “password”, then click OK:

»* Login to GeneMapper® ID-X r$_<|

User Mame ‘gmidx “ |

Password: “ |

Database Host: ‘ sgsngom 1058 o |

@ 1999-2002 Applied Biosystems. All Rights Reserved.

[ Mew Host... ][ Delete Host ][ Diefault Host ] [ OK H Exit H Help ]

3. If prompted, specify a new password. Keep a record of the new
password. Click OK.

Note: The gmidx account requires you to set a new password
when you log in for the first time. If you follow this procedure
after first log in, the passwords for the accounts listed may be
different from the passwords listed in this guide.

IMPORTANT! Do not lose the password for the gmidx account.
Applied Biosystems cannot retrieve these passwords.

4. Read the license agreement, then click Yes if you agree with the
terms.

5. Review the license agreement and product warranty, then click
Accept.
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Connecting to a new host

If you install more than one multi-user database computer, any client
computer can connect to any of the databases if the client is on the
same network as the database computers.

Note: All client computers connecting to multi-user database
computers must be running the same version of GeneMapper /D-X
Software.

Users must set up separate user accounts on each multi-user database
computer that they wish to access.

Note: For detailed information on setting up user accounts, see the
GeneMapper® ID-X Software Version 1.0 Administrator s Guide.

To make the multi-user database computers available to client
computers, perform the following steps for each client computer:

1. Click New Host in the Login to GeneMapper ID-X dialog box.

#* Login to GeneMapper® ID-X

User Mame |gmidx L |

Password: | |
GeneMapper®

lD'X Database Hosk: |sgsngcm108 w |

@ 1999-2009 Applied Biosystems. All Rights Resenved.

[ Mew Host,., H Delete Host H Default Host ] [ 84 H Exit H Help ]

2. Complete the information in the New Host dialog box:
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#* New Host E|

Enter new GeneMapper® ID-% host information:

Machine Type: | Stand-alone v

a. In the Host Name field, enter the full computer name or
IP address of the multi-user database host you want to
access. If the GeneMapper® ID-X Software cannot connect
to the database host, the error message “You have entered
an invalid host” is displayed. Click OK to exit, then re-
enter the database host information.

b. Select the applicable machine type.
c. Click OK.

The Login window is updated to include the name of the new
database host. The User Name list reflects the user accounts on
the new database host. See the GeneMapper® ID-X Software
Version 1.0 Administrator s Guide for additional information.
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Logging out of the GeneMapper® ID-X Software

You can close the GeneMapper® ID-X Software by:

* Selecting File » Logout.

* Selecting File » Exit.

» Clicking 3 (Close).
When you log out of the GeneMapper® ID-X Software with a project
that has unsaved changes, the software prompts you to save or

discard the changes you made since the last time you updated the
project.

Save Project

If you used the File » Logout command, the login window re-opens
after you select either Yes or No. The GeneMapper /D-X Software
closes completely if you use either File » Exit or i3 (Close).
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Additional post-installation tasks

Importing
application data

Creating user
accounts and
configuring
administrative
functions

Setting up
autoanalysis

If you exported application data from GeneMapper® ID Software
v3.2.x or GeneMapper® ID-X Software v1.0/1.0.1/1.1/1.1.1 before
you installed GeneMapper® ID-X Software v1.2, you may wish to
import the data objects (projects, analysis methods, etc.) into the
GeneMapper® ID-X Software v1.2 database host computer.

Select Tools » GeneMapper ID-X Manager. Then in the
GeneMapper ID-X Manager window, click each tab to import the
corresponding objects into GeneMapper ID-X v1.2.

For information on creating user accounts and configuring the
Security Manager, Audit Manager, and E-Signature Administrator,
see the GeneMapper® ID-X Software Version 1.0 Administrator s
Guide.

If you installed the GeneMapper® ID-X Software as either a remote
autoanalysis configuration, co-installation, or Data Collection client
installation, follow the procedures in Chapter 7, “Setting up
autoanalysis on the 31xx or 3730 computer,” on page 81.
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This chapter covers:

Overview of autoanalysis process. .. ................... 74
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Autoanalysis instrument and software configurations . . . . .. 77
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Overview of autoanalysis process

74

Autoanalysis The autoanalysis process occurs in the following sequence:

Note: The 3500 instrument supports local analysis only.

. Close the GeneMapper® ID-X Software and start the

Autoanalysis Manager.

. On the Data Collection (DC) computer, select the plate to run

and schedule the run.

. When the DC Software finishes a run as specified in the results

group, the data (.fsa or .hid sample files) are stored in the
destination specified by the DC Software results group.

. The DC Software sends the message “Run Completed” to the

Autoanalysis Manager. The Autoanalysis Manager searches for
jobs every two minutes.

. When the Autoanalysis Manager receives a “Run Completed”

message, it adds the job to its job queue.

. The Autoanalysis Manager:

a. Opens the GeneMapper® ID-X Software.

b. Creates a project using the name of the Data Collection
results group.

. The GeneMapper® ID-X Software:

a. Imports the .fsa or .hid sample files from the location
specified in the Data Collection results group.

b. Uses the settings specified in the Data Collection plate
record (panels and bins, analysis method, size standard) to
analyze the .fsa sample files.

c. Saves the project, then associates the data in the project
with the GMIDX security group (for information on
security groups, see the GeneMapper® ID-X Sofiware
Version 1.0 Administrator’s Guide).
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d. Stores the results in the default host GeneMapper® ID-X
Software database.

Note: The default host is the GeneMapper ID-X Software
computer that is specified in the Login dialog box of the
computer that performs autoanalysis. For instructions on
changing the default host, see “Connecting to a new host”
on page 68.

8. The Autoanalysis Manager:
a. Closes the GeneMapper ID-X Software.

b. Updates the status of the run in the Autoanalysis Manager
job queue.

For information on the Autoanalysis Manager, see the
GeneMapper® ID-X Software Online Help.
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Determining if your computer can perform
autoanalysis

Autoanalysis An autoanalysis configuration uses:

software « Data Collection Software — Runs the instrument and collects

components data from samples. See “Instrument and software options for
autoanalysis” on page 77 to determine if your Data Collection
computer supports autoanalysis.
* Autoanalysis Manager — Communicates between the Data
Collection Software and the GeneMapper® ID-X Software. It
queues jobs and tracks the status of their processing. A job can
contain a single run or multiple runs as part of a result group.
+ GeneMapper® ID-X Software v1.2 — Creates a project,
imports .fsa or .hid sample files, analyzes the data, then saves
the results in the multi-user database.
Figure 2 shows the relationship and interaction between the
autoanalysis components.
Stores in specified location _fsa ?ill']eds h|d Raw data GeneMapper ID_X
Software
Opens
Data Collection Autoanalysis Creates project
Software Manager +—
Run Closes and Multi-user database
complete reports status Analysis Methods
i

Figure 2 Relationship between autoanalysis components

Autoanalysis can be performed from a multi-user database computer
or a client computer but requires the Autoanalysis Manager.

To determine if your computer contains the Autoanalysis Manager,
select Start » Applied Biosystems » Autoanalysis Manager »
Autoanalysis Manager 5.0.
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Autoanalysis instrument and software
configurations

With autoanalysis, the GeneMapper® ID-X Software v1.2 can
automatically analyze data generated on the following systems:

Table 7 Instrument and software options for autoanalysis

Compatible Data Collection
Software and Operating Systems

) '« 3500 Data Collection v3.0
E} Applied Biosystems 3500 Genetic Analyzer * Windows Vista SP 1

Genetic Analyzer Instrument

e 3130 Data Collection v3.0/

Applied Biosystems 3130/3130x/ 3130x/ Data Collection v3.0
Genetic Analyzer e Windows XP, SP 2 or later

'« 3100 Data Collection v2.0/
3100-Avant™ Data Collection v2.0

]
ABI Prism® 3100/3100-Avant™
E} Genetic Analyzer van « Windows 2000, SP 3 or later
: and
Windows XP SP 2 or later

e 3730 Data Collection v3.0

Applied Biosystems 3730 e Windows XP, SP 2 or later
Genetic Analyzer¥

I The 3730 Genetic Analyzer does not include the 3730x/ 96-capillary configuration. The 48-capillary
configuration is validated for analysis of data generated from Identifiler® kits using single-source data
samples only.
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Overview of autoanalysis setup

Local and remote autoanalysis

With the analyzers listed in Table 7, you can configure the Data
Collection Software and the GeneMapper® ID-X Software v1.2 to
perform data collection and then analyze the data automatically,
without user interaction.

The GeneMapper® ID-X Software v1.2 can be a co-installation or a
client installation on the DC computer (for local autoanalysis).
Alternatively, the software can be installed on a non-DC computer
and configured for remote autoanalysis on a 31xx or 3730 DC
computer only, as shown Figure 3.

Note: If you install the GeneMapper® ID-X Software on the same
computer as the Data Collection Software (co-installation), you must
manually import the panel and bin files. See the GeneMapper® ID-X
Software Online Help for information on this procedure.

Note: Ifyou install the GeneMapper /D-X v1.2 software on the 3500
DC computer (co-installation), you will be able use the 3500
computer to perform local autoanalysis. However, if you install the
GeneMapper ID-X v1.2 software on a non-DC computer, you will
not be able to access the 3500 computer to perform remote
autoanalysis.

DC
computer
Local

Data
Collection
Software

Autoanalysis

=R= N

Unshared

folder

@ GeneMapper /D- Collection Em GeneSM?tpper ID-X
Software oftware

DC Non-DC
computer computer
Remote
Autoanalysis

or Data

Software

Shared
folder

78

Figure 3 Examples of autoanalysis configurations
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Data processing options

The Autoanalysis feature of the GeneMapper® ID-X Software allows
you to set up a Data Collection run, then process the data
automatically in the GeneMapper® ID-X Software. Autoanalysis can
occur:

* Locally — from the DC computer when the Data Collection
Software and GeneMapper® ID-X Software are installed on the
same computer.

* Remotely — from the non-DC computer when the Data
Collection Software (on the 31xx or 3730 only) and
GeneMapper® ID-X Software are installed on different
computers.

The Autoanalysis Manager is automatically installed when you
install the GeneMapper® ID-X Software on a:

* DC computer as a co-installation or client installation
* Non-DC computer for remote autoanalysis

Autoanalysis Manager is not installed when you install the
GeneMapper® ID-X Software on a non-DC computer in a stand-
alone configuration.

If the Autoanalysis Manager is not installed on your computer and
you want to use the computer for autoanalysis, uninstall the
GeneMapper® ID-X Software (see “Uninstalling the GeneMapper®
ID-X Software” on page 126), then reinstall for Remote
Autoanalysis.

Before setting up  Before you set up autoanalysis:

autoanalysis * Ensure that the Data Collection Software and

GeneMapper® ID-X Software are installed in either of the
following configurations:

DC DC Non-DC
computer computer computer
Remote
Local
Autoanalysis Autoanalysis
Data or Data

;i GeneMapper /D-. N GeneMapper ID-X
Collection m@_ Mepper | Collection B apper |

Software Unshared Software Shared

folder folder

Figure 4 Configurations necessary for autoanalysis
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If the software is installed on different computers, ensure that
the two computers are connected to the same network.

Ensure that the remote GeneMapper® ID-X Software computer
has the Autoanalysis Manager installed: Select Start »
Applied Biosystems » Autoanalysis Manager »
Autoanalysis Manager 5.0.

If the Autoanalysis Manager is not installed, you must uninstall
the GeneMapper® ID-X Software, then reinstall the
GeneMapper® ID-X Software and select the Remote
Autoanalysis option (see “Uninstalling the GeneMapper® ID-X
Software” on page 126).

Import or create analysis methods, panels, bins, and size
standards on the multi-user database host computer (see the
GeneMapper® ID-X Software Online Help).

If you install the GeneMapper® ID-X Software on the same
computer as the Data Collection Software (co-installation), you
must manually import the panel and bin files. See the
GeneMapper® ID-X Software Online Help for information on
this procedure.
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Setting up autoanalysis on the 31xx or 3730

computer
The autoanalysis set-up process consists of four procedures as shown
in the following table.
. See
Procedure Action page
1. Create a User Account. 81
2. In the Data Collection Software, create an instrument protocol for 82
autoanalysis.
3. In the Data Collection Software, create a results group for autoanalysis. 84
4. In the Data Collection Software, create a plate record for autoanalysis. 92

Procedure 1: Creating a user account for autoanalysis

IMPORTANT! The user account for autoanalysis must exist on the
computer that is specified as the host computer, which may be
different from the computer on which you run autoanalysis and store

data files (see Figure 6 on page 104).

Create a user account for autoanalysis in GeneMapper® ID-X with

the following settings (for information on creating user accounts, see
the GeneMapper® ID-X Sofiware Version 1.0 Administrator’s Guide).
In the GeneMapper /D-X Software Security Manager New User

screen:

1. Deselect Pre-expire.

IMPORTANT! Ifthe account is set to pre-expire, you must log in
with the account one time to change the password before you

use the account for autoanalysis.
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2. Select Scientist profile.

Note: If you create custom profiles for your system, create a
profile for autoanalysis with the following minimum privileges:
Read privileges for Panel Manager, Size Standard, Analysis
Method; Read and Update privileges for creating and analyzing
projects.

For Full Name, enter Remote Autoanalysis, Data Collection
Client, or Co-installation.

Deselect Show EULA.

Associate the user account with any user group. The project that
autoanalysis creates, analyzes, and saves is associated with the
GeneMapper® ID-X Software security group, which is
accessible by all user groups.

When you are finished, go to Procedure 2 and create an instrument
protocol.

Procedure 2: Creating an instrument protocol for

autoanalysis
Creating
instrument
protocols
82

An instrument protocol contains all the settings needed to run the
instrument, including the protocol name, type of run, run module,
and dye set.

IMPORTANT! Create new instrument protocols after installing or
reinstalling the GeneMapper® ID-X Software v1.0/1.0.1/1.1/1.1.1.

For more detailed information about instrument protocols, see your
instrument user guide.

1.

In the Navigation pane of the Data Collection Software, select
GA Instruments » <Instrument Name> » Protocol Manager.

2. In the Instruments Protocols section, click New to open the

Protocol Editor.
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I8 Foundation Data Collection Version 3.0 - No User is logged in

Fle vew Help
A3

@ Acarstumers | M o retrumerts » gas13051 » Fretocoi Manager

EDatebase Manager Instrumert Protocals

B Ellgas1304

Crae B —
Name | Run Modue. Dye Set | Description
31305 patialFill_1 3130SpatialFin_1 Created with o1
3 L1 a1 L1 Created with pi
F_POP4_36_spectral Spect3s_POP4_1 F

F F

ubdoduie Manager
CHrun History
EDJack_3130x

55_POP4_36_speciral Spect36_POP4_1 5
<

Crew ] [oome ) [rmor ] [mwen )

Anaiysis Protocols

Voo | Apptostion

New Ean Detete por

3. In the Protocol Editor, enter instrument protocol information:
a. Enter a name for the protocol.
b. (Optional) Enter a description for the protocol.
c. Select REGULAR in the Type drop-down list.

d. Select the HIDFragmentAnalysis36_POP4_1 run module
in the Run Module drop-down list.

e. Select the appropriate dye in the Dye Set drop-down list
(see the table that follows to determine the dye).

Protocol Editor ‘E‘
Mame: | HD M 3a
Dezctiption: 3b
Type: [REGULAR v 3c
Fun Module:  HIDFragmertanatysis36_POP4_1 | 3d
Dye et [as = | 3e
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Kit Dye Set
AmpF(STR® COfiler® Kit F
AmpF(STR® Profiler Plus® Kit
AmpF(STR® Profiler Plus ID Kit
AmpF(STR® SGM Plus® Kit
Other 4-Dye AmpF(STR® Kits
AmpF(STR® SEfiler™ Kit ' G5
AmpF(STR® Identifiler® Kit
AmpF(STR® Yfiler® Kit
AmpF(STR® Minifiler™ Kit
Other 5-Dye AmpF(STR® Kits

f. Click OK.

When you are finished, go to Procedure 3 to create a Results Group
for autoanalysis.

Procedure 3: Creating a results group for autoanalysis

84

Overview of
results groups

Create a Results Group for each computer that performs
autoanalysis.

A Results Group specifies the file names and storage location
(shared folder) for .fsa sample files, and the user name and password
for the GeneMapper® ID-X Software computer that performs
autoanalysis. After you create the Results Group, the software can
perform autoanalysis.

Create new Results Groups after installing or reinstalling the
GeneMapper® ID-X Software v1.2.

IMPORTANT! The maximum number of .fsa sample files that the
Data Collection Software can assign to a Results Group, when using
the Analysis Type GeneMapperIDX-Generic or GeneMapperIDX-
<computer name>, is 7000. After you collect 7000 .fsa sample files
in a Results Group, you must create a new results group.
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For more detailed information about results groups, see your specific
instrument user guide.

Allelic ladder IMPORTANT! If a run folder does not contain an allelic ladder, the
requirements and  samples are reported as off ladder (OL) in the GeneMapper® ID-X
results groups  Software. For more information, see the GeneMapper® ID-X
Software Online Help.

To set up the Data Collection Software so at least one allelic ladder is
present in each run folder, create a results group that groups by plate
as described below, instead of by run (which is the default).

Creating a results  For each GeneMapper® ID-X Software client computer that runs
group for autoanalysis:

autoanalysis o _
1. In the Navigation pane of the Data Collection Software, select

GA Instruments » Results Group.

2. Click New to open the Results Group Editor, then click the tabs
of the results groups and enter the information as described
below.

Entering Results Group Information

1. In the General tab, enter the Results Group Name. This name is
assigned as the default autoanalysis project name (all results for
autoanalysis are stored in this GeneMapper® ID-X Software
project). The Results Group name must be unique to the Data
Collection Software.

2. (Optional) Enter the Results Group Owner.

3. (Optional) Enter a Results Group Comment.
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mResuIts Group Editor

GEHEY&l'AnaIysis Destination | Maming

Results Group Name:

Results Group Cwner: | — 2

Results Group Comment:| — 3

OK | Cancel |

Entering Analysis Parameters

1.
2.

Click the Analysis tab.

For the Analysis Type, select GeneMapperIDX-
<computer name> (the name of the host or client computer on
which you intend to run autoanalysis).

Note: The computer names are added to the Analysis Type list
when you install the GeneMapper® ID-X Software as a co-
installation or client installation on the Data Collection
computer, or choose the remote autoanalysis option for the
non-DC computer (31xx and 3730 computers only).

Note: You cannot perform autoanalysis if you select
GeneMapperIDX-Generic.

Select Do Autoanalysis.

Select Results Group Entry Complete to start autoanalysis
after all samples that use the same results group (all samples on
the plate) have been run and to ensure that each run folder
contains an allelic ladder.

IMPORTANT! If a run folder does not contain an allelic ladder,
the samples are reported as off ladder (OL) in the GeneMapper®
ID-X Software. For more information, see the GeneMapper®
ID-X Software Online Help.
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5. In the Login ID and Password fields, enter a GeneMapper®
ID-X Software user account username and password for the
computer on which you intend to run autoanalysis. This account
must exist on the computer specified as the default host. The
default host computer may not be the computer on which you
perform autoanalysis (the computer running Autoanalysis
Manager) (see Figure 6 on page 104).

IMPORTANT! The GeneMapper /D-X Software requires a user
account with a Scientist or higher security profile to perform
autoanalysis (see “Procedure 1: Creating a user account for
autoanalysis” on page 81).

m Results Group Editor

General Analysis | Destination | Maming

’—Analysis Type

GaneMapper- 3130x1-08 Step 2

Login 1D |
Passward | J Step 5
Analysis Action Step 3

v Do Autoanalysis [ Results Group Entry Compl

Analyze Now | \ Step4

Ok | Cancel |
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Specifying the Sample File Storage Location
1. Click the Destination tab.
2. Specify the location in which to store the .fsa sample files

3. Select Use Custom Location.

r_lf';_‘:!Results Group Editor

4. Set the destination as described in the following table.
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For... Do the Following...
Local autoanalysis 1. Click Browse, then select a destination.
2. Click Test.
Remote autoanalysis 1. Before you specify the destination, verify that you can connect to the

computer on which you intend to store the .fsa sample files and that the
shared folder you previously created (see page 84) is accessible from
that computer.

Note: To optimize data sharing, store files on a non-GeneMapper® ID-X
Software computer (see page 103).

a. On the Data Collection computer, select the Start menu, then select
Run.

b. Enter the names of the computer on which you intend to store the
.fsa sample files and the shared folder, using the following format:

\\<server name>\<shared folder name>
For example: \GMID_PC\Remote_AutoAnalysis

= Type the name of a program, Folder, dacument, ar
5 Inkernet resource, and Windows will open it for you.

Qpen: | WEMD_PCRemote_AutoAnalysis w

I Ok H Cancel ][ Browse...

c. Click OK.

If Windows Explorer opens to the shared folder on the designated
computer, the computer and shared folder are accessible. Close
Windows Explorer, then proceed to step 2.

If Windows Explorer does not open to the shared folder on the
designated computer, either the computer is not accessible, or the
shared folder is not set up correctly. Troubleshoot your network,
computer, or shared folder problem before proceeding to step 2.

2. In the Destination tab (see page 88), enter the names of the computer
on which you intend to store the .fsa sample files and the shared folder,
using the format shown in step 1b.

3. Click Test to test the location path name connection.
If the test:

e Passes — The message “Test succeeded” is displayed.

¢ Fails — The message “Could not make the connection. Please check
that the Path Name is correct” is displayed. Make sure you correctly
entered the computer and shared folder names, then troubleshoot your
network or computer before continuing.
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Creating sample and name plates

In the naming tab, provide information about the samples:
1. Click the Naming tab.

2. From the Format list in the Sample File Name Format section
(top), select a series of fields to create unique sample names, for
example, Well Position, Sample Name, and Capillary Position.

Results Group Editor

| General| Analysis | Destmalinn‘ Naming | Automated Processing
~Sample File Mame Format
Evarmnle A12_Sample3_007 fsa
Filename is greater than 13 characiers
Frafix | ‘

Step2 — Name Delimiter v

Format |

“WBH Position V| ‘Sample Name ~ | |Capillary Number V‘ |<nune> 7 H

S | |

— Filg Extengian 53

(- Run Folder Name Faormat
Exarmple EinppliedBiosystermsWDC\DataCollectionbinmarntylSeqF ateds
INVALID MAME: Folder name does not have a unigue identifier in it.
Step 3 — Frafis: [ ‘
Mame Delimitsr

Format |

Flate Name ~||=none= |

RN

3. From the Format list in the Run Folder Name Format section,
select Plate Name.

IMPORTANT! To ensure that the run folder includes at least one
allelic ladder for genotyping, the run folder must be grouped by
plate, not by run.

When you select Plate Name, an INVALID NAME message is
displayed. Disregard the message. All samples from the plate
are saved into one run folder.

Note: Sample name, run folder name, and path name,
combined, can contain no more than 250 characters.
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Setting automated processing

1. Click the Automated Processing tab.

Note: This tab is available only if you selected
GeneMapperlDX-<computer name> in step 2 on page 86.

2. Select Only when the result group is complete to analyze after
all the samples that use the same results group have been
processed and click OK to save the results group.

Results Group Editor il

General| Analysis | Destination| MNaming AulnmaledF’mcessingI

Autoanalysis is performed : Select only
(ﬁ' Only when the results group is complete when the
‘ T Wwhen every run completes result
group is
complete

OK Cancel

When you are finished, go to Procedure 4 to create a plate record for
autoanalysis.
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Procedure 4: Creating a plate record for autoanalysis

Defining new
plate information

92

A plate record specifies the instrument protocol, results group, and
analysis parameters for a run of samples. For more information about
plate records, see your instrument user guide.

IMPORTANT! Create new plate records after installing or
reinstalling the GeneMapper® ID-X Software v1.2, and before each
autoanalysis run. This procedure is provided in the GeneMapper®
ID-X Software Online Help.

In the Navigation pane of the Data Collection Software, click the
Plate Manager icon to display the Plate Editor.

IMPORTANT! Before you can create a new plate record, you must
specify or import the size standards, panels, and analysis methods in
the GeneMapper /D-X Software, then synchronize the Data
Collection Software with the GeneMapper® ID-X Software (see
page 115).

1. Click New to open the New Plate Dialog box.

2. Enter a name for the plate. The Plate Name is the name assigned
to the run folder that resides in the shared folder where the .fsa
sample files are stored.

3. (Optional) Enter a description for the plate.

4. Select GeneMapperIDX-<computer name> (the name of the
computer that you intend to have run autoanalysis) in the
Application drop-down list.

5. Select 96-well or 384-well in the Plate Type drop-down list.
6. Enter names for the owner and operator.

7. Click OK.
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New Plate Dialog
Marne: ‘ ‘ 2
Description:
3
Application ‘None N ‘
Plate Type: |96 well 5 5

Owvnet Mame:

Operator Name:

X

.

Describing the For each row in the Plate Editor (see page 94), describe the sample:
sample
1. Enter the name of the sample.
After you make selections for the first row, you can select the
row, then press Ctrl+D to auto-populate (fill-down) the
remaining rows.

2. (Optional) Enter a comment about the sample. This information
is displayed in the Comment field of the Samples table in the
GeneMapper® ID-X Software.

3. Enter a priority number to specify the sequence in which the
samples are run.

4. Specify sample type:

a. Select Allelic Ladder as the sample type for the
appropriate wells (you need at least one allelic ladder per
plate to allow genotyping).

b. Select Positive Control or Negative Control for your
control samples to allow an automated concordance check
to ensure that the:

» Positive control produces the expected profile.

» Negative control does not contain peaks called above
your peak amplitude threshold.
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Plate editor

1

2 3

10.

4

Boersopperpaorson | | | 5
Filz  Edit

Pl |l

Pl §ishlegy

Well | Sawpe bame | Coemirt | Friont| | SanpleTlge  Sios tancerd, Paiel, Analysis Miahod | SrpE,| UlerDefined1  UserDefivedZ | UserDefined 3, [esuds Grown 1 | Instrument Froioool

c. Select Sample for all other samples.

Select a size standard from the drop-down list.

IMPORTANT! If the expected size standard, panel, and analysis
method are not listed, you may need to synchronize the Data
Collection Software and the GeneMapper® ID-X Software. See
page 115.

Select an applicable AmpF(STR® kit and panel from the
drop-down list.

Select an analysis method from the drop-down list.
(Optional) Enter text in the user-defined text columns.

Select the results group you created using the procedures on
page 84.

Select the instrument protocol you created using the procedures
on page 82. Click OK.

5 6 7 8 9 10

Oper i

&

O

=

[

Dectizipon

‘ ~

11

3] (o)

For more information on the Plate Editor, see your instrument user
guide. For information on performing autoanalysis and using the
Autoanalysis Manager, see the GeneMapper® ID-X Software Online
Help.
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Setting up autoanalysis on the 3500 computer

The autoanalysis set-up process consists of four procedures as shown
in the following table.

. See
Action
Procedure page
1. Create a User Account. 95
2. In the 3500 Series Data Collection Software, create an HID analysis protocol. 96
3. In the Data Collection Software, add the HID analysis protocol to an assay. 99
4, In the 3500 Series Data Collection Software, create a plate with autoanalysis 100
enabled.

Procedure 1: Creating a user account for autoanalysis

On the 3500 Data Collection computer, create a user account in
GeneMapper ID-X for autoanalysis with the following settings (for
information on creating user accounts, see the GeneMapper® ID-X
Software Version 1.0 Administrator’s Guide). In the GeneMapper ID-
X Software Security Manager New User screen:

1.

In the GeneMapper /D-X main window, select Admin » Security
Manager.

Select File » New User.

Deselect Pre-expire.

IMPORTANT! If the account is set to pre-expire, you must log in
with the account one time to change the password before you
use the account for autoanalysis.
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4. Select Scientist profile.

Note: If you create custom profiles for your system, create a
profile for autoanalysis with the following minimum privileges:
Read privileges for Panel Manager, Size Standard, Analysis
Method; Read and Update privileges for creating and analyzing
projects.

. For Full Name, enter Data Collection Client or

Co-installation.

. Deselect Show EULA.

. Associate the user account with any user group. The project that

autoanalysis creates, analyzes, and saves is associated with the
GeneMapper® ID-X Software security group, which is
accessible by all user groups.

When you are finished, go to Procedure 2 and create an HID analysis
protocol.

Procedure 2: Create an HID analysis protocol

96

For detailed procedures, see the 3500 Series User Guide.

. In the 3500 Series Data Collection Software, select Library in

the menu bar to access the Library workflow.

Libtary Maintenance Tools = Manage ~ Preferences  Hell

3
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2. Access the HID
Analysis
Protocols library.

3. Click =g Create.

4. Inthe Create New
HID Analysis
Protocol dialog
box (Figure 5 on
page 98), specify
settings (see
Table 8 on
page 98).

5. Select the
remaining
secondary
analysis items,
then click Save.

Note: If the
analysis method,
size standard, or
panel of interest
is not displayed in
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k= 3500 Data Collection Software

: Dashboard Edit - Library Mainten
% Libran Resources “F dagate
Filker:
* Manage
Plates
Aszays ﬂ Pratacal Marm:

File Mame Conventions:

Results Group

|I Analyze

Instrument Protocals

Dye Sets

Size Standards

Bazecaling Pratocols
Sizecalling Protocols

Qs Protocals

Sequencing Analysis Protocols
MicroSeqlD Protocols

Fragment Analysis Protocols

i

ik Work flow

a list, re-select the secondary analysis software instance to
update the list, or re-start the GeneMapper ID-X software.
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:._.'_? Create Mew HID &nalysis Protocol =3
Setup a GeneMapper® ID-X Protocol ﬁ

* Protocal Mame: | Identifiler for autoanalysis|

Description:

Application Type: |HID

* Secondary Analysis Softaare: IGeneMapperID)( v‘

* Secondary Analysis Softaare Instance: IGeneMapperID)(-3SDD-ID)( v‘

Properties

* Analysis Method: [HID_Full Range_75 -

* Size Standard: | G3600_LZ +Normalization (8 ~|

Panel: [Identifiler_CODIS_viX -

Figure 5 Create New HID Analysis Protocol

Table 8 HID Analysis protocol settings

Setting Description
Protocol Name Name of the protocol. Names must be unique.
Description Optional text entry.
Lock When enabled, allows the entry to be unlocked and modified only

by the user who created it, the administrator, or another user with
unlock permissions. Useful when your system includes the SAE
module (described in the 3500 Series User Guide).

Application Type Automatically set to HID.
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Table 8 HID Analysis protocol settings

Setting Description

Secondary Analysis Software Confirm that GeneMapperIDX is displayed for the Software Type
and the Data Collection computer name is displayed for the
Software Location. If these items are not displayed, make sure the
GeneMapper ID-X software is installed on the Data Collection
computer.

IMPORTANT! The secondary analysis software must be installed
and properly configured with the 3500 Series Data Collection
Software before it is listed as a selection in this screen.

IMPORTANT! The auto-analysis settings you specify for the plate
to run with this protocol must contain the same secondary software
and location settings. For more information, see “Procedure 4:
Create a plate with autoanalysis enabled” on page 100.

Secondary Analysis Software Name of the Data Collection computer.
Instance

Properties GeneMapper® ID-X analysis method, size standard, and panel to
use for auto-analysis.

Note: If the appropriate items are not listed, restart the
GeneMapper® ID-X software and the Data Collection Software.

Procedure 3: Add the HID analysis protocol to an assay

1. Select Library in the menu bar to access the Library workflow.

Library Maintenance Tools ™ Manage ™ Preferences  Help

2. Access the k= 3500 Data Collection Software

Assays library. ;
Dashboard Edit ~ Library  Mainken
3. Select an assay % Linran Resources = e at
. ate
for the kit you
will run using
auto-analysis. Filker: | Al
* Manage
Plates
Y m |P.ssay Marne
L& —
|§ File Mame Convertions 1 YF_P
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4. Click Duplicate, select the “Copy of” assay you created,
then click Edit . .

5. Change the assay name to “original name for autoanalysis.”

6. In the GeneMapper IDX Protocol field, select the HID analysis

protocol you created on page 96 (HID analysis protocol =
GeneMapper IDX Protocol).

:._.E__ Edit Assay IF_POP4 x| for auto-analysis

ES)
7]
Color | Dark Cyan -

Setup an Assay

* Azsay Marne: IF_POP4  for auto-analysis

Application Type: |HID -

Protocals

Do you wish to assign multiple instrurnent protocols to this assay? @ Mo () Yes

* Instrument Protocol: IHID36_POP4><I_GS v‘ Edit ICreate New‘
* 0C Protacol: [ 85_Lsen-400) | [Edit| [Create New]
Genebdapper ID¥ Protocal: IIdentifiIerfor auto-analysis v‘ Edit ICreate New‘

7. Click Save.

Procedure 4: Create a plate with autoanalysis enabled

Create a plate 1. In the 3500 Series Data Collection Software Dashboard, click

Create Plate From Template.
2. Select an HID template, then click Open.

In the Define Plate Properties screen, set the plate properties.

Specify 1. Inthe lower part of the Define Plate Properties screen, select
auto-analysis Perform Auto-Analysis.
settings
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Plate Details
*Mame: | IF autoanalysis Crvrrer:
*Murmber of Wells: @ 96 () 96-FastTube (D) 384 Barcode:

* Plate Type: |HID -
* Capillary Length: (36 = [ cm Description:
*Paolymer: |POP4 -

« Secondary Analysis il pcﬁm Auta-Analysis
* Software Type: ’GeneMapperID)( v‘
* Software Location: IGeneMapperID)(-3SDD-ID)( v]

*Username:  Autoanalysisl
*Password: eessss

*Auto Analysis is performed: @ Only when the results group is complete (0 When every injection complete

2. Confirm that GeneMapperIDX is displayed for the Software
Type and the Data Collection computer name is displayed for
the Software Location. If these items are not displayed, make
sure the GeneMapper /D-X software must be installed on the
Data Collection computer.

3. Enter the username and password for the account you created
for autoanalysis on page 95.

4. Select Only when the results group is complete to ensure that
each run folder contains at least one allelic ladder sample.

IMPORTANT! If a run folder does not contain an allelic ladder
sample, the samples are reported as off ladder (OL) in the
GeneMapper® ID-X Software.

5. Click Save, then click Assign Plate Contents to advance to the
next screen.

—h

Assign plate Assign sample names and sample types as described in the 3500
contents Series User Guide.
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2. Select the wells containing samples, click Actions in the Assay
group box, then select Add from Library.

Assays Mews

Actions | ¥ Edit
[] co_Pop4_d M/f x| bA' Duplicate
@ [ 1 pp pnpd . x | . Rename

Al [
Delete

Add From Library

Save To Library b
Impaort Frorm File

Select Related Yifells
3. Select the assay you created on page 99.
4. Select a file name convention and a results group.

Flle i‘lame_l:"ﬁnven.tions I _Resti.lt.s. ﬁroups
Actions ™ Actions

| My FHC /' m @ || My Sequencing Results Gro... /' m

IMPORTANT! If a run folder does not contain an allelic ladder
sample, the samples are reported as off ladder (OL) in the
GeneMapper® ID-X Software. Select a results group that places
at least one allelic ladder sample in a run folder.

5. Select Save Plate.

6. (Optional) To save this plate as a template for future
autoanalysis runs, select Save As Template.
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Recommended data processing tasks

Optimizing data sharing

Overview If you store .fsa or .hid sample files on a GeneMapper® ID-X
Software computer (i.e., the computer that creates the project AND
stores the sample files), only the computer that created the project
can reanalyze the project. As a result, any other computer must
reassociate the files to reanalyze the project.

Additionally, if you export/import reference data and projects
following installation but do not reassociate .fsa or .hid sample files,
you can view results and make or edit allele calls, but you cannot
reanalyze the projects.

To reanalyze projects:

1. Move .fsa or .hid sample files to a non-GeneMapper® ID-X
Software computer to optimize file sharing.

2. Reassociate the .fsa or .hid sample files with the imported
projects (Edit » Define New Sample Path) to view raw and
EPT data and reanalyze the imported projects on your client
computer.

Figure 6 shows the recommended configuration for optimizing data
sharing.
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Add
. Samples
Sample files to Project

(.fsa or .hid) Networked Server (raw data) !
Shared
Folder

Client computer

Data Run <
Collection | completed| | Autoanalysis Opens | |GeneMapper ID-X
Software > Manager Closes, then Software
updates status

Multi-user Database
Computer (Host)

Autoanalyze l,"

GeneMapper ID-X

Can access Software

results and

B Project
reanalyze without arJ1d
reassociating
S — Pl
Client computer L _} —— J@
GeneMapper ID-X database

Software

Figure 6 Autoanalysis configuration to optimize data sharing

The following sections describe data optimization in detail. For
additional details on how to perform each procedure, see the
GeneMapper® ID-X Software Online Help.

Settingup a Remote autoanalysis of data requires a shared folder in which to
shared folder store .fsa sample files. To make the sample data files accessible to all
(remote client computers, set up the shared folder on a computer that is not
autoanalysis only) running the GeneMapper® ID-X Software.

On the computer on which you intend to store the .fsa sample files:

1. Select Start » My Computer, or double-click My Computer
on your desktop, then double-click the drive on which you want
the shared folder.

2. Select File » New » Folder.
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3. Name the folder (for example, Remote_Autoanalysis).
4. Right-click the new folder, then select Properties.

5. In the Sharing tab, select Share this folder.

6. (Optional) Enter a comment for the folder.

7. Click OK.

Remote_Autoanalysis Properties |E|®

General| Sharing |Security Customize

= *Y'ou can share this folder with other uzers on your

network. To enable sharing for thiz folder, click Share this
falder.

(O Do not share this foldsr
(&) Share this folder 5

Share name: |F|em0te_AutoanaIysis

Comment: |Shared folder for remate autoanalysiz I 6
User limit: (®) Mavimum allowed
O Allow this number of users: l:l
To et permissions for users who access this
falder over the netwark, click Permissions. Sl
To c:o_nfigure zettings for offine access, click
Caching.

QK H Cancel ][ Apply ]
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Setting
permissions and
security for the
shared folder
(Windows XP
Only)

106

If you use a Microsoft® Windows® XP operating system, modify the
permissions and security settings of the shared folder:

1.
2.

Right-click the shared folder, then select Properties.
Select the Sharing tab, then click Permissions.

In the Permissions for <shared folder name> dialog box, select
the check box for Full Control in the Allow column.

Click OK.

Remote_Autoanalysis Properties ﬂ

| General| Sharing | Security. | Customize|

— REPEEUELEE) Permissions for Remote_Autoanalysis
network, Toe

folder. * Share Permissions |

(O Do not share this fif
(%) Share this folder

!ﬁ Everyone
Share name: | Remd|
Caomment: Share

User limit: *) M4
O alg

Group or user names:

To zet permissions for

it e (o ] Permizzions for Everyone

. . Full Control 3
To configure settings f h
Caching. ange
Read
‘ 4

D‘K H Cancel ][ Apply ]
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5. Select the Security tab, then click Add.

6. In the Select Users, Computers, or Groups dialog box, enter
Guest in the “Enter the object names to select” field.

7. Click OK.

Remote_Autoanalysis Properties

General | Sharing | Security |Eust0mize|

Group or user names:

@ d Select Users, Computers, or Groups
g H select this object type:
< - |Users,Groups, or Built-in security principals | [ Object Types... ]
From this location:
|na.ab.applera.net | [ Locations... ]
Permis:
Ful Enter the object names to select [examples):
Mog| [Guest ErEriiamE 6
Fed
List
e Co e
it |
For special permissions or for advanced settings, 7
click Advanced.
QK ] [ Cancel ] [ Apply ]
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8. In the Group or user names list box in the Security tab,
configure guest access:

a. Select Guest.

b. Select the check box for Full Control in the Allow
column.

c. Click OK.

Remote_futosnalysis Properties

General Sharing| Security |Eust0mize
Group or uzer names:
!ﬁ Adminiztrators [0 4BPF 3514 dministrators) L
€7 CREATOR DWNER
ﬂ Guest [D4BPF3514Guest) 8a
o A
< | &
[ Add... ] [ Bemove ]
Permizzions for Guest A"\‘JW Deny 8b
Full Control 0 &=
Modity O
Fead & Execute O
List Folder Contents O
Read O —
write O »
For special permissions or for advanced settings.
click Advanced. =
I 8c
[ QK ] [ Cancel ] [ Apply ]

The shared folder is now configured for use.
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Setting  If you use a Microsoft® Windows® XP operating system, modify the
permissions and permissions and security settings of the shared folder:
security for the . .
shared folder 1- Right-click the shared folder, then select Properties.

(Windows g:qslig 2. Select the Sharing tab, then click Advanced Sharing.

i test Properties [

| General | Sharing iSecurity | Previous Versions | Customize |

Network File and Folder Sharing

test
Shared

MNetworl Path:
WWALSTINFIVISTA test

Advanced Sharing

Set custom permissions, create multiple shares, and set other
advanced sharing options.

[ '@'MvancedSharing... ]
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3. Set permissions:

a. Click Permissions.

b. In the Permissions for <shared folder name> dialog box,
select the check box for Full Control in the Allow column.

Advanced ;Sh.aﬁng

[7] Share this folder
Settings

Share name:

[test

Limit the number of simultaneous users to:

Comments:

|
[ Permissions ” Caching ]

.

| Permissions for test

Share Permissions

Apply

Group or user names:

82 Everyone

Permissions for Everyone

Step 3a

Step 3b

Full Control
Change
Read

Leam about access control and permissions

0K [ Canca ||

Apply

] |

4. Click OK.
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5. Select the Security tab, then click Edit.

=

o isi-l’r’opeﬁiﬁ

General I Sharing | Security | Previous Versions Customjzel

Object name:  Cest

GI‘OLIp ar User names:

82, Authenticated Users -
52 5YSTEM K
2 AustinF1 (SOFTWARE AustinF1)

B2 Adminictratnre (a0ictind Tyicka) Adminictratareb o
b

[ i
To change permissions, click Edit.

Permissions for Authenticated
Users

Allow Deny

| »

Full control

Modify

Read & execute
List folder contents
Read

Write

For special permissions or advanced settings,

click Advanced.

m

s

Leam about access control and pemissions

ok | [ Cancd | [ Apply
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6. Add a guest user:

a. Click Add.

b. In the Select Users, Computers, or Groups dialog box,
enter Guest in the “Enter the object names to select” field.

. Permissions for test

Security

e
..'*'-

Object name:  C\test

Group or user names:

52 SYSTEM

2, AustinF1 (SOFTWARE: AustinF1)

82, Administrators (sustinf Tvista"Administratars)
33_; Users (gustinf 1vista®sers)

Flhvetcaostoos |

Step 6a

FPemizsions for Authenticated
Users Alow

Full control =
Modify

Fead & execute

List folder contents

Read

Leam about access control and permissions

[ ok ][ cancel

] Apply

| Select Users, Computers, or Groups
Select this object type:
Users, Groups, or Builtin security principals
From this location:
soft na ab applera net

Enter the object names to select (examples):

'
Object Types...

Check Names 6b

&
|

7. Click OK.

QK

H
i
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configure guest access:
a. Select Guest.

b. Select the check box for Full Cont
column.

c. Click OK.

Remote_futosnalysis Properties

8. In the Group or user names list box in the Security tab,

rol in the Allow

General | Sharing | Security | Customize

Group or user names:

!ﬁ Adminiztrators [D4BPF 351 \Administrators] -
€7 CREATOR DWNER

ﬂ Guest [D4BPF3514Guest)

o A
< ¥
[ Add... ][ Bemove ]
Permizzions for Guest Allpey Deny
Full Control e
Modify

Read & Execute
Lizt Folder Contents
Read

write

ooooono

v

For special permissions of for advanced settings,
click Advanced. —

Step 8a

- Step 8b

[ ok

H Cancel ][ Apply ]

Step 8¢

The shared folder is now configured for use.

Importing and  Depending on your current network configuration, you can import

reassociating
data files

and reassociate the files in two ways:

 If the .fsa or .hid sample files are stored on a non-

GeneMapper® ID-X Software computer other than a user’s
local computer — The software saves the full networked path
location of the .fsa or .hid sample files (for example:

//server/folder/folder*.fsa). Because the

path location is

available to GeneMapper /D-X, any computer in the network
can access the project and reanalyze it without reassociating the

files.
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 If the .fsa or .hid sample files are stored on a user’s local
computer (that is, the computer that creates the project
AND stores the sample files) — The software saves the path
location of the .fsa or .hid sample files, but not the name of the
computer on which the files reside (for example:
C:/folder/folder*.fsa). The local computer can reanalyze the
files because GeneMapper /D-X searches the local computer for
the .fsa or .hid sample files. However, the name of the computer
is not available to other computers running GeneMapper ID-X,
therefore they cannot reanalyze projects without first
reassociating files (Edit » Define New Sample Path) (see
Figure 7 for file storage comparisons).

Sample files (.fsa) stored on a server computer not running GeneMapper® /D-X Software

Non-GeneMapper ID-X

Multi-user Database Server computer Computer File Storage
Computer (not running
GeneMapper® ID-X Software)
GeneMapper® ID-X Client
Software computer

GeneMapper®
Multi-user ID-X Software

database

Creates a project, adds samples from server. Can open the project and reanalyze
Sample information, including full path location, because full path location
(\Lab01\Project1)) is stored in database. (\Lab01\Project1Y) is stored in database.

Sample files (.fsa) stored on a computer running GeneMapper® ID-X Software
Local Computer

Multi-user Database File Storage
Computer
GeneMapper® ID-X Client
Software computer

GeneMapper®
Multi-user ID-X Software
database

C:\Lab01\Project1\.fsa files

Can open the project but cannot reanalyze
without reassociating because computer name
is not stored in database.

Creates a project, adds samples from local computer.
Sample information with partial path location
(\Lab01\Project1)) is stored in database.

Local computer name is not stored in the database.

Figure 7 Storing .fsa or .hid sample files: non-GeneMapper®
ID-X Software computer vs. local computer)
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Synchronizing GeneMapper® ID-X Software with the Data
Collection Software

After you install the GeneMapper® ID-X Software, and any time you
create or change analysis methods, panels, or size standards in the
GeneMapper® ID-X Software, you must synchronize the new data
with the Data Collection Software before you can select the updated
items in the Data Collection Software plate record.

To synchronize the GeneMapper® ID-X Software with the Data
Collection Software:

1. Select File » Exit to close the GeneMapper® ID-X Software.

2. Verify that the Data Collection Software is running on the Data
Collection computer. If not, start the Data Collection Software.
For information on starting the Data Collection Software, see
“Starting the Data Collection Software on the Data Collection
computer” on page 32.

3. On your deskt(;g:
Double-click ..2... GeneMapper ID-X v1.2,
or
Select Start » All Programs » Applied Biosystems »
GeneMapper » GeneMapper ID-X v1.2 and log in.

GeneMapper® ID-X Software v1.2 Installation Guide 115



n Chapter 7 Setting Up Autoanalysis

Recommended data processing tasks

116 GeneMapper® ID-X Software v1.2 Installation Guide



Appendix A

“ Installing the Generic Updater
o Software

This appendix covers:

B Installing the Generic Updater Software. ............... 118
B Removing the Generic Updater Software . .............. 120
117
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Installing the Generic Updater Software

Installing the Generic Updater Software

118

The Generic Updater software is an add-on to the 3730 and 3130
Data Collection 3.0 software only. Use the Generic Updater to define
custom plates and write sample files to be used with the
GeneMapper® ID-X Software v1.2.

If you have either 3730 or 3130 Data Collection 3.0 software
installed on your computer, and you do not intend to install the
GeneMapper® ID-X Software v1.2 on the same computer for either
local or remote autoanalysis, you can install the Generic Updater
software on the Data Collection computer.

The generic Plate Editor, residing in the Plate Manager function, has
columns for GeneMapper /D-X plate data that can be edited as text
fields. The software provides you with the option to add generic or
non-automated GeneMapper ID-X plate definitions and sample files
to your Data Collection Software installation.

To review the requirements for installing the Generic Updater
software, see “Installation options” on page 3.

1. Insert one of the following CDs into the Data Collection
computer CD drive:

»  GeneMapper® ID-X Software
Version 1.2 Full Install CDs - Disk 1

» GeneMapper® ID-X Software
Version 1.2 Client Install CD

2. Ensure that the Data Collection Software is running (see
page 32).

3. On the splash screen, click Software Extras, then on the next
screen click Generic Updater.

4. On the following screen, click Install Generic Updater.

5. Click Browse, then select a location for the Generic Updater zip
files and click Unzip to extract the files.

6. Remove the GeneMapper® ID-X Software v1.2 CD from the
CD drive.
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7. Navigate to the extracted folder on your hard drive. Open the
Deployment-Generic folder, then double-click RegisterGMID-
XGeneric.exe. A

8. Click OK when you see the message “Application
GeneMapper® successfully registered in JNDI.”

9. Stop the Data Collection Software and restart your computer.

Start the Data Collection Software and open the Viewer window,
then use the Plate Manager to create new GeneMapper /D-X Generic
plate definitions.

For instructions on creating and using GeneMapper® ID-X Generic
plates, see the User Guide for your specific instrument.

Resolving If RegisterGMID-XGeneric.exe reports an installation problem:

installation )
problems 1. Close the window and check the JNDIRegistrationGMID-
XGeneric log file in the extracted folder.

2. Check your Data Collection installation to verify that the Data
Collection Software is running.

3. Try running RegisterGMID-XGeneric.exe again.
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Removing the Generic Updater Software
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IMPORTANT! If you decide to install the GeneMapper /ID-X
Software directly onto the Data Collection computer or as a remote
autoanalysis configuration, you must first remove the Generic
Updater Software from the Data Collection computer.

To uninstall the Generic Updater Software:

1.

Ensure that the Data Collection Software is running (see
page 32).

Navigate to the extracted folder on your hard drive.

Open the Deployment-Generic folder, then double-click
UnRegisterGMID-XGeneric.exe to remove the
GeneMapperIDX-Generic option from the Data Collection
Software.

Click OK when you see the message “Application
GeneMapper® successfully unregistered in JNDI.”

Verify that the Generic Updater Software was removed:
a. Open the Data Collection Viewer window.
b. Open the Plate Manager.

c. Verify that the GeneMapperIDX-Generic option is not
available as an application choice.

Delete the Generic Updater Software files from your hard drive.
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Resolving If UnRegisterGMID-XGeneric.exe reports a problem and the
uninstallation  Generic Updater software is still displayed in the Data Collection
problems Viewer Plate Manager:

1. Check the JNDIRegistrationGMID-XGeneric log file in the
extracted folder.

2. Check your Data Collection installation to verify that the Data
Collection Software is running.

3. Run UnRegisterGMID-XGeneric.exe again.
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Troubleshooting
the Installation

This appendix covers: H
124

B Troubleshooting tasks . .............................

B Troubleshooting tools . ............................. 131
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Troubleshooting tasks

Disabling firewall protections

During a full GeneMapper® ID-X Software installation, the security
firewall settings may prevent the database from installing. You may
see Windows security alerts that prompt you to “keep blocking” or
“unblock” the security firewalls. Alternatively, it may appear that the
installation was complete, but when you start the software, the
database may not launch.

1. Before installing GeneMapper ID-X v1.2, disable the firewall
settings:

¢ For Windows XP select: Start » Control
Panel » Windows Firewall

* For Windows Vista select: Start » Settings » Control
Panel » Windows Firewall

2. During installation, if you are prompted with Window firewall
alerts, click Unblock and proceed with installation.

If the software application doesn’t launch:

» Uninstall the software (see “Uninstalling the
GeneMapper® ID-X Software” on page 126).

* Disable the firewall settings

* For Windows XP select: Start » Control
Panel » Windows Firewall

» For Windows Vista select: Start » Settings
» Control Panel » Windows Firewall

or
Disable the firewall settings for earlier Windows operating
systems. Go to Start » Settings » Control

Panel » Security Center for Windows online support.

3. Reinstall the software for your specific /D-X configuration.

4. Reset firewall.
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Canceling an installation

DO NOT cancel an installation before the installation process is
finished. If you do so, or if the installation otherwise stalls, you may
need technical support to perform an uninstall. To uninstall your
installation, see “Uninstalling the GeneMapper® ID-X Software” on
page 126. If uninstallation fails, contact your local Applied
Biosystems technical support organization.

General installation solutions

Note: You may need to send the GeneMapper ID-X install and MSI
log files to Applied Biosystems Technical Support if the
troubleshooting procedures in this appendix do not solve the
installation problem.

If you have trouble installing the GeneMapper® ID-X Software v1.0
or v1.1 on your computer:

Task See page
1. Obtain the installation log file. | 125
2. Check the database installation. | 126
3. If necessary, uninstall the software. . 126
4. If necessary, have a knowledgeable technician run the 128

clean-up utility.

Obtaining the To obtain the installation log file, go to:
installation log file  x:{installdir}\AppliedBiosystems\GeneMapper ID-X where x is
the drive on which the GeneMapper ID-X Software is installed and
{installdir} is the user-selected installation path.

* You will find 2 logs for the full installation:
— GMIDXInstall.log
— GMIDX_MSIl.log

* You will find 2 logs for the client installation:
— GMIDXClientInstall.log
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Uninstalling the
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Troubleshooting tasks

Checking the 1.

database
installation
2.
3.
4.

X Software

1.

— GMIDXClient_MSI.log

Select Start » All Programs » Accessories »
Command Prompt.

Enter sqlplus, then press Enter.
Enter the user name, system, then press Enter.

Enter the password, manager, then press Enter.

» Ifa“Connected to:” message is displayed, the database is
installed correctly.

* Ifno “Connected to:” message is displayed, the database is
not installed correctly. Complete Table 6, “Troubleshooting
Checklist,” on page 131, then contact Applied Biosystems
Technical Support.

To uninstall the GeneMapper® ID-X Software and the multi-user
database:

If you are uninstalling a co-installation, Data Collection client
installation, or a remote autoanalysis configuration, start the
Data Collection Software (see page 32).

Close the GeneMapper® ID-X Software and all other
applications, then restart the computer before proceeding with
the uninstall.

IMPORTANT! If you do not restart the computer before
proceeding with the uninstall and/or if the uninstall does not
complete successfully the first time, perform this procedure a
second time. If the uninstall still does not work, have a
knowledgeable technician review and proceed with “Running
the clean-up utility” on page 128 or contact Applied Biosystems
Technical Support to proceed.

3. Select Start » Control Panel.
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4. Double-click Add or Remove Programs.

Note: If a message indicates that you need administrator rights
or privileges, log off the computer, then log on again as a user
with administrator privileges.

Note: If you receive an error message, dismiss the message and
proceed to “Running the clean-up utility” on page 128.

Select the GeneMapper® ID-X Software.
Click Change/Remove. The InstallShield Wizard opens.

In the Welcome page, select Remove, then click Next.

© N o o

At the prompt, click OK to verify the uninstall.

» Ifyou are uninstalling a Co-installation or Data Collection
client installation, the message below appears. Be sure the
Data Collection Service Console is open, then click OK to
start the uninstall.

Warning

!

j Please make sure Data Collection services are on during the Uninstall,

Click OK to continue the Uninstall,

* If you are uninstalling a remote autoanalysis configuration,
no message is displayed; however, the Data Collection
Software must be running and the Service Console must be
open on the remote Data Collection computer to uninstall a
remote autoanalysis configuration.
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9. When the Maintenance Complete window opens, finish the
uninstallation process:

IMPORTANT! If you uninstall a co-installation or Data
Collection client installation, stop the Data Collection Software
before restarting your computer by clicking Stop All in the
Service Console.

Service Console

Messaging Service

Data Service

Instrument Service

Wigwer

[sem +——— Stop Al

a. Select Yes, I want to restart my computer now.

b. Click Finish.

Running the Run the clean-up utility under only the following conditions:
clean-up utility * You have attempted the uninstall procedure using the
Add/Remove Program uninstall option,
and
* The GeneMapper ID-X software files were not removed or were
only partially removed.

Have only a knowledgeable technician run the msicuu2.exe utility to
clean up the remaining files.
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To perform the clean-up procedure:

1.

Insert the GeneMapper® ID-X Software CD, then go to
DVD/CD-RW Drive » Utilities.

Run msicuu2.exe to install the utility.

Launch the utility from the desktop icon or from
Start » Programs » Windows to install.

Select the GeneMapper /D-X application from the list provided,
then click Remove.

a. Check to ensure that the gmidx install folder and
oraclegmidx folder under your {installdir} are deleted.

b. Check to ensure that the Oracle folder in the Program Files
folder is deleted.

Delete variable strings:

IMPORTANT! Steps 5 and 6 must be performed carefully and
correctly. If they are not performed correctly, other applications
could stop working, and the stability of your system could be at
risk. If you do not feel comfortable performing these steps,
please contact your system administrator to perform them for
you.

a. Right-click on My Computer, then select Properties.
b. Click the Advanced tab.

Click Environment Variables.

o

d. In the System variables Variable pane, delete the words
ORACLE_HOME and ORACLE_HOSTNAME.

e. In the System variables Variable pane, select the Path
variable and click Edit.

f. Remove the path to oraclegmidx from the path
environment variable.

g. Click OK to exit the Environment Variables dialog box and
OK to exit the System Properties dialog box.
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6. Go to Start » Run and enter regedit. In the left-pane of the
Registry Editor, open the following folders sequentially:
HKEY_LOCAL_MACHINE » SYSTEM

» CurrentControlSet » Services.

a. In the Services folder, remove all Oracle folders containing
IFA letters only.
* OracleIFAGMIDXCMan
* OraclelFADataGatherer
* OracleIFAGMIDXTNSListener
* OracleIFAAgent
* OraclelFAClientCache
* OracleIFAGMIDXCMAdmin
* OracleServicelFA
* OracleJobSchedulerIFA

b. Log off and reboot the system.
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Troubleshooting tools

Complete the Troubleshooting Checklist and Interdepartment Forms
before contacting Applied Biosystems Technical Support for
assistance.

Checklist
Table 6 Troubleshooting Checklist

Check Information for Technical Support

Summarize the problem:

Can you repeat the problem?
If yes, list the steps that you perform:

No o~ b=

Applied Biosystems personnel that you have contacted:
[ Field Applications Specialist

[ Field Service Engineer

[ Technical Support

[ Sales Representative

A Order Administration

[ Other
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Check

Information for Technical Support

Computer specifications:

e Operating system:

e \Version:

* Processor:

e Memory:

e Hard disk space:

e Hard disk configuration:

Software installed:

1 Data Collection Software version:

1 Status of Data Collection services:
1 GeneMapper ID-X Software version:
[ Other Applied Biosystems software:

Computer login information:
e User privileges:
¢ Local or networked domain:

Software configuration installed:
[ Co-installation

d Remote autoanalysis

[ Stand-alone

1 Multi-user database

Instrument and instrument computer information:

e Model:

e Data Collection Software version:

e Status of Data Collection services:
e Other Applied Biosystems software:
¢ Capillary length:

¢ Capillary lot number:

¢ Run module:

e Dye set:

Chemistry kit or reagent, with version number:
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Check Information for Technical Support

Be prepared to send to Technical Support:

e Installation log file (page 125)

e Exported panels

e Exported bins

e Exported size standard definition

¢ Exported analysis method

e Sample (.fsa) files

¢ GMIDXInstall.log or GMIDXClientInstall.log
e PanellmportLog.txt

¢ Printed results

Interdepartmental forms

Answering questions in the following forms helps manage complex
troubleshooting procedures. Your answers will be shared among
support groups, product groups and software development teams at
Applied Biosystems.

To address any issues that may arise when installing or running the
software, please answer the applicable list of questions, and collect
the necessary files before contacting Technical Support.
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For installation  Collect the following files and complete the questions below:

ISSUCS  For full installation:

* GMIDXInstall.log
* GMIDX_MSl.log

For client installation:
* GMIDXClientInstall.log
* GMIDXClient_MSI.log

Do the computer and operating system meet the required computer specifications? (See Chapter 2,
“Installation Requirements,” on page 13.)
List any potential discrepancies.

Did you receive any error messages or alerts? If so, what did they say? (if possible, take screen
captures.) At what point during the installation process did these errors/alerts occur?

How many installation attempts have you tried?

Are you logged in to the local computer?

Is the TCP/IP configured?

Do you have administrative privileges?

Is this setup stand-alone, networked, or connected to a Genetic Analyzer?
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For post-
installation
related issues

Do the computer and operating system meet the required computer specifications? (See Chapter 2,
“Installation Requirements,” on page 13.)
List any potential discrepancies.

Problem description:

Did you receive any error messages or alerts? If so, what did they say? (If possible, take screen
captures.) At what point did these errors/alerts occur?

Is the problem reproducible?

Steps taken prior to encountering or to reproduce the problem:
1.
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B Definitionof terms . ...t 138
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Definition of terms

Client installation

Co-installation
(31xx, 3730, 3500)

Dashboard
(3500)

Data collection
client installation

310 Data
Collection (DC)
computer

31xx or 3730 Data
Collection (DC)
computer

138

A computer installed with the GeneMapper® ID-X Software only
(software with no database). A client installation computer connects
to a full installation computer to access the multi-user database. A
client can be installed on a Data Collection (DC) computer, or it can
be installed on a non-Data Collection (non-DC) computer in either a
remote autoanalysis or stand-alone configuration.

A full or client installation (database and GeneMapper® ID-X
Software) on a Data Collection computer that can be set to
communicate locally with the Data Collection Software for the
collection and processing of .fsa sample files (31xx or 3730) or .hid
sample files (3500), and for the analysis of data. Co-installation with
full GeneMapper ID-X software is not recommended in a multiuser
database configuration because the multi-user host is limited to a
one-client-connection.

The Dashboard displays gauges, instrument information,
consumable information, and maintenance notifications that provide
a quick overview of the usage of each consumable and the status of
the 3500 computer.

An installation (GeneMapper® ID-X Software only) on a Data
Collection computer that can be set to communicate locally with the
Data Collection Software for the collection and processing of .fsa or
.hid sample files, and for the analysis of data. Connects to a multi-
user database host computer to access, analyze, and share data and
analysis settings.

A stand-alone computer with Data Collection Software that controls
the Genetic Analyzer instrument and generates .fsa sample files used
for analysis by the host or client computer GeneMapper® ID-X
Software.

A computer with Data Collection Software that controls the Genetic
Analyzer instrument and generates .fsa sample files used for analysis
by the host or client computer GeneMapper® ID-X Software. Can
support a co-installation or client installation.
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3500 Data
Collection (DC)
computer

Data Collection
Software

Full installation

Genetic analyzer

GMID
GMID-X

Local area
network

Local
autoanalysis
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A computer with Data Collection Software that controls the Genetic
Analyzer instrument and generates .hid sample files used for analysis
by the host or client computer GeneMapper® ID-X Software.
Supports a co-installation and client installation.

The software on the Data Collection computer that controls the
Genetic Analyzer instrument and generates the .fsa or .hid (3500)
sample files used for analysis.

A computer installed with both the multi-user database and
GeneMapper ID-X Software.

A full installation computer can be part of a multi-user database
configuration, or it can be a data collection (DC) or non-data-
collection (non-DC) computer having no interaction with other
computers. A full installation can occur in any of the following
configurations, depending on the function of the computer:

e Co-installation
* Remote Autoanalysis
e Stand-alone

The capillary electrophoresis instrument, controlled by the Data
Collection Software, which generates .fsa or .hid sample files (.hid
on the 3500).

Abbreviation for GeneMapper® ID Software.
Abbreviation for GeneMapper® ID-X Software.

A communications network that serves users within a confined
geographical area.

A co-installation (database and GeneMapper® ID-X Software) or
client installation (GeneMapper® ID-X Software only) that is set up
on a Data Collection computer to locally communicate with the Data
Collection Software for the collection and processing of .fsa sample
files, and the analysis of data.
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Multi-user
database host
computer

Non-Data
Collection

(non-DC)
computer

Stand-alone
configuration

Upgrade
installation

Remote
autoanalysis

140

A computer on which data is stored on a central, multi-user database.
Commonly referred to as the host computer, from which other client
computers (computers without a database) can access, analyze, and
share data. Can be installed for a remote autoanalysis or stand-alone
(non-DC) configuration.

A non-Data Collection computer that may or may not be connected
to a local area network (LAN). Can be a client installation or full
installation, with a stand-alone or remote autoanalysis configuration.

A full installation (database and GeneMapper® ID-X Software) or
client installation (GeneMapper® ID-X Software with no database)
on a non-Data Collection computer that does not remotely
communicate with the Data Collection computer. Can be the
database host or client computer in a multi-user database
configuration.

A software upgrade from GeneMapper® ID-X Software
v1.0/1.0.1/1.1/1.1.1 to GeneMapper® ID-X Software v1.2. The
upgrade can be performed on a client or full installation computer
that already has the v1.0/1.0.1/1.1/1.1.1 software installed. However,
to upgrade on a client computer, you must also upgrade the computer
that hosts the full multi-user database installation.

A full or client installation on a non-Data Collection computer that is
set up remotely to communicate with the Data Collection computer
(Data Collection Software) for the automatic acquisition and analysis
of data. Can be the database host or client computer in a multi-user
database configuration.
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Documentation

The following related documents are shipped with the system:

Document Part number Description

GeneMapper® ID-X Software | 4376327 Describes how to configure the administrative

Version 1.0 Administrator’s features of the software, maintain the

Guide GeneMapper ID-X and database dashboard
software, and use the command-line interface.

GeneMapper® ID-X Software | 4375574 Explains how to set up the software, set up a

Version 1.0 Getting Started project, and analyze the example data provided

Guide with the GeneMapper ID-X Software.

GeneMapper® ID-X Software | 4396773 Explains how to set up the software for mixture

Version 1.1 (Mixture Analysis analysis and analyze the example data

Tool) Getting Started Guide provided with the GeneMapper ID-X Software.

GeneMapper® ID-X Software | 4382693 Describes process quality values (PQVs) and

Version 1.0.1/1.1 Reference algorithms.

Guide

GeneMapper® ID-X Software | 4385670 Provides an easy-to-follow workflow for using

Version 1.0.1/1.1 Quick the mixture analysis tool.

Reference Card

GeneMapper® ID-X Software | 4426481 Describes process quality values (PQVs) and

Version 1.2 Reference Guide algorithms.

GeneMapper® ID-X Software | 4426482 Provides an easy-to-follow workflow for using

Version 1.2 Quick Reference
Card
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Documentation

Obtaining information from the Help system

Portable document format (PDF) versions of this guide and all
supporting documentation are available on the documentation CD
available with your software.

Note: To open the user documentation on the CD drive, you need the
Adobe® Acrobat® Reader® software, which is available from
www.adobe.com or
www.appliedbiosystems.com/support/software.

Note: For additional documentation, see “How to obtain support” on
page X.

Obtaining information from the Help system

142

The GeneMapper ID-X Software and the database Dashboard
Software have a Help system that describes how to use each feature
of the user interface. Access the Help system by doing one of the
following:

+ Click in the toolbar of the GeneMapper® ID-X Software or
database Dashboard Software window.

* Select Help » Contents and Index.
* Press F1.

You can use the Help system to find topics of interest by:
* Reviewing the table of contents
» Searching for a specific topic
» Searching an alphabetized index
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Documentation
Send us your comments

Send us your comments

Applied Biosystems welcomes your comments and suggestions for
improving its user documents. You can e-mail your comments to:

techpubs@appliedbiosystems.com

IMPORTANT! The e-mail address above is for submitting comments
and suggestions relating only to documentation. To order documents,
download PDF files, or for help with a technical question, see “How
to obtain support” on page X.
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